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Legal Information
Copyright ©1994 - 2008 Sonic Solutions. All Rights reserved. Roxio Creator 2009, Roxio Easy 
Media Creator, Easy CD & DVD Creator, Easy CD & DVD Burning, WinOnCD, Retrieve, DLA, 
Music Disc Creator, MyDVD, Backup MyPC, Disc Copier, Label Creator, Sound Editor, Creator 
Classic, JUST!BURN, WOCBlock, CinePlayer, Roxio Updater, Media Manager, VideoWave, 
PhotoSuite, Roxio Easy DVD Copy, DVD Info Pro, Disc Image Loader, Easy Audio Capture, 
RecordNow!, DMX, CineMagic, Drag-to-Disc, Roxio Backup, Media Import, Disc & Device 
Utility, Express Labeler, Slideshow Assistant, Multi Photo Enhance, Panorama Assistant, Photo 
Email Assistant and all styles and templates are protected by copyright law and international 
treaties. Unauthorized reproduction or distribution of these programs, or any portion of them, 
may result in severe civil and criminal penalties, and will be prosecuted to the maximum extent 
possible under law. Use of these products is subject to the acceptance of the license agreement 
included in this product.

Sonic, Sonic Solutions, Roxio, the burning disc logo, Roxio Creator, Roxio Easy Media Creator, 
WinOnCD, PhotoSuite, VideoWave, the burning CD logo, Easy CD & DVD Creator, Easy CD & 
DVD Burning, Disc Copier, MyDVD, Creator Classic, JUST!BURN, Easy DVD Copy, BackUp 
MyPC, CinePlayer, RecordNow! and Drag-to-Disc are trademarks of Sonic Solutions, which may 
be registered in some jurisdictions. All other trademarks used are owned by their respective 
owners.

SOME OR ALL OF THE FOLLOWING APPLY TO THIS PRODUCT:

Portions of the software are provided by Apple Computer, Inc. Copyright © 2004 Apple 
Computer, Inc.

DivX and the DivX logo are registered trademarks of DivXNetworks, Inc. in the U.S. and other 
countries.

MPEG Layer-3 and mp3PRO audio coding technology licensed from Coding Technologies, 
Fraunhofer IIS and THOMSON.

http://www.iis.fhg.de/amm 
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Portions utilize Microsoft Windows Media Technologies. Copyright © 1999-2004 Microsoft 
Corporation. All Rights Reserved. Windows Media and the Windows logo are trademarks or 
registered trademarks of Microsoft Corporation in the United States and/or other countries. 

VST Plug-in Technology by Steinberg Copyright © 2004 Steinberg Media Technologies AG. 
Steinberg is a registered trademark of Steinberg Soft- und Hardware GmbH. 

Some digital content © 1994-2001 Hemera* Technologies Inc. All Rights Reserved. * Trademark 
of Hemera Technologies Inc.

Ogg Vorbis audio compression technology provided courtesy of the Xiph.Org Foundation.

libfishsound 

----------------------- 

Copyright (C) 2003, 2004 Commonwealth Scientific and Industrial Research Organisation 
(CSIRO) Australia 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE ORGANISATION 
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------ 

libvorbis and libogg 

------------------------------------------------ 
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Copyright (c) 1994-2004 Xiph.org Foundation 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY O 
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

------------------------------------------------------------- 

libflac and libflac++ 

----------------------------------------- 

Copyright (C) 2000,2001,2002,2003,2004 Josh Coalson 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

-------------------------------------------------------- 

dsfOggDemux, dsfOggMux, dsfVorbisDecoder, dsfVorbisEncoder.dll, dsfNativeFLACSource, 
dsfFLACDecoder, dsfFLACEncoder, libOOOgg, libOOOggSeek 

------------------------------------ 

Copyright (C) 2003-2005 Zentaro Kavanagh 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE ORGANISATION 
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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Audio effect engine licensed by Algorithmix. http://www.algorithmix.com

'Dolby' and the double-D symbol are trademarks of Dolby laboratories.

This product contains one or more programs protected under international and U.S. copyright 
laws as unpublished works. They are confidential and proprietary to Dolby Laboratories. Their 
reproduction or disclosure, in whole or in part, or the production of derivative works therefrom 
without the express permission of Dolby Laboratories is prohibited. Copyright 1992-1997 by 
Dolby Laboratories, Inc. All rights reserved.

Manufactured under license from Dolby Laboratories.

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit 
expressly disclaim all implied, express or statutory warranties including, without limitation, the 
implied warranties of merchantability, non-infringement of third party rights and fitness for a 
particular purpose. Neither the developers nor the distributors will be liable for damages, 
whether direct, indirect, special, incidental, or consequential, as a result of the reproduction, 
modification, distribution or other use of the TWAIN Toolkit.

Music recognition technology and related data are provided by Gracenote®. Gracenote is the 
industry standard in music recognition technology and related content delivery. For more 
information visit www.gracenote.com.

CD and music-related data from Gracenote, Inc., copyright © 2006 Gracenote. Gracenote 
Software, copyright © 2006 Gracenote. This product and service may practice one or more of the 
following U.S. Patents: #5,987,525; #6,061,680; #6,154,773, #6,161,132, #6,230,192, #6,230,207, 
#6,240,459, #6,330,593, and other patents issued or pending.  Some services supplied under 
license from Open Globe, Inc. for U.S. Patent: #6,304,523.

Gracenote  the Gracenotelogo, the Gracenote logotype, and CDDB are  registered trademarks of 
Gracenote. MusicID  and the "Powered by Gracenote" logo are trademarks of Gracenote.
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For more information on using the Gracenote Service, visit: www.gracenote.com/corporate

Portions Copyright 1997, Chris Losinger 

Portions of this product were created using LEADTOOLS © 1991-2001, LEAD Technologies, Inc. 
ALL RIGHTS RESERVED.

Product includes the 3ivx Filter Suite. Copyright © 3ivx Technologies Pty. Ltd., 1999-2003, All 
rights reserved. 3ivx is an international trademark.

Some digital content provided by Digital Vision.

Certain templates and images: © 2004 ArtBuilders.

Some audio content provided by Darklab Sound.

Some audio content is provided by Todor Kobakov from spineproductions.net.

Some content courtesy of Artbeats. www.artbeats.com

Some digital image content © 2006 Jupiterimages Corporation. All Rights Reserved.

Some audio content © 2006 Ian Nieman Music. All rights reserved.

Portions Copyright 1997-1998 Intel Corporation. 
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This product uses the LAME MP3 Encoder library (the “Library”). The Library is licensed under 
the GNU Library General Public License, Version 2, 1991. For a copy of the complete 
corresponding machine-readable source code for the Library, send your request to Sonic 
Solutions, 101 Rowland, Suite 110, Novato, CA 94945 Attn: Legal Department. Processing, 
shipping, and handling charges will apply.

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO 
LICENSE FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) 
ENCODING VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 
VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A 
CONSUMER ENGAGED IN A PERSONAL AND NONCOMMERCIAL ACTIVITY AND/OR 
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED BY MPEG LA TO PROVIDE 
MPEG-4 VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER 
USE. ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, 
INTERNAL AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG 
LA, LLC. SEE HTTP://WWW.MPEGLA.COM.

PSP is a registered trademark of Sony Computer Entertainment, and Memory Stick is a 
trademark of Sony Corporation.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc., and any use of such 
marks by Sonic Solutions is under license. Other trademarks and trade names are those of their 
respective owners.

TiVo and the TiVo logo are registered trademarks of TiVo Inc. or its subsidiaries.

This product is protected by certain intellectual property rights of Microsoft Corporation. Use or 
distribution of such technology outside of this product is prohibited without a license from 
Microsoft or an authorized Microsoft subsidiary.

Windows Pre-Installation Environment. Disaster recovery applications included in this product 
may use the Microsoft® Windows® Preinstallation Environment software from Microsoft 
Corporation (“WinPE”). The WinPE softare included with this software may be used for boot, 
diagnostic, setup, restoration, installation, configuration, test or disaster recovery purposes only.  
NOTE: THIS SOFTWARE CONTAINS A SECURITY FEATURE THAT WILL CAUSE YOUR 
COMPUTER SYSTEM TO REBOOT WITHOUT PRIOR NOTIFICATION TO YOU AFTER 24 
HOURS OF CONTINUOUS USE. WinPE may not be used as a general purpose operating system 
or as a substitute for a fully functional version of any operating system product. Use of WinPE is 
“as-is.”
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Changes
The material in this document is for information purposes only and is subject to change without 
notice. While reasonable efforts have been made in the preparation of this document to assure its 
accuracy, Sonic Solutions assumes no liability resulting from errors or omissions in this 
document, nor from the use of the information contained herein.

Sonic Solutions reserves the right to make changes in the product design without reservation and 
without notification to its users.

Disclaimer
This product may allow you to reproduce materials in which you own the copyright or have 
obtained permission to copy from the copyright owner. Unless you own the copyright or have 
permission to copy such materials from the copyright owner, you may be violating copyright law 
and be subject to the payment of damages and other remedies. If you are uncertain of your rights, 
you should contact your legal advisor.

This product may be protected by one or more of the patents listed at http://www.sonic.com/
innovation/patents.
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Welcome to Roxio Creator
Welcome to Roxio Creator, the all-in-one digital media solution. 

Designed for beginners and experts alike, Creator makes it all easy—from 
simple and practical tasks, such as creating a backup copy of a disc, to fun 
and creative projects such as creating a home movie complete with 
introductions, transitions, music, and effects. 

Get creative and have fun with this powerful, intuitive, and easy-to-use 
suite of digital media components. Do more with your digital music, 
favorite photos, mobile phone, cherished video, and your important data 
files. Find all the tools you need in one place, with one easy-to-use interface. 

About this guide
This guide provides an overview of Creator and explains how to use its 
most popular features. For detailed information about how to use all of the 
features of Creator, see the online Help described in Where to find more 
information on page 31.

Some of the components available in Creator may not be described in this 
guide. Each component includes detailed online Help, which you can find 
under the component Help menu or by pressing F1.

Depending on the version of Creator you are using, some of the 
components described in this guide may not be available.
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Installing Creator
Follow this procedure to install Creator. 

To install Creator using the installation disc: 

1 Insert the Creator installation DVD into your DVD drive.

If Autorun is enabled on your computer, the Creator installation 
window appears automatically and you can skip step 2 and step 3.

2 Choose Start > Run.

3 Type d:\setup (substitute the appropriate letter of your DVD drive 
for d).

4 Follow the installation instructions that appear on the screen.

To install Creator using downloaded files:

1 Navigate to the Creator install package.

2 Double-click the setup.exe file.

3 Follow the on-screen instructions.
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Getting to know Creator
Start your digital media projects from Creator’s main window. Double-click 
the Creator desktop icon to begin.

Creator’s main window, featuring the project 
categories and frequent tasks.

Starting a task
Click one of the project category tabs on the left side of the window, and a 
task list appears on the right. Choose a task by clicking on its name. Some of 
the tasks are built into the main Creator window; others open in a separate 
window.
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Creator: What you can do
There are so many great things you can do with Creator. Here’s a partial list 
and how to get started:

Working with audio
You will find links to these tasks by selecting the Music-Audio project tab:

■ Make an audio CD that you can play anywhere. Select the Burn Audio 
CDs task.

■ Create an MP3 disc that holds hundreds of songs in MP3, WMA, or 
WAV format. Select the Burn MP3 CDs task.

■ Rip audio files from a CD to your computer. Select the Rip task.

■ Quickly capture (record) audio from Internet radio and other 
sources using your computer’s sound card. Select the 
Capture Audio from Sound Card task.

■ Record and edit sound clips and audio files, and to create your 
own audio mixes. Select the Edit Audio task.

■ Create music compilations to play on your home or car stereo, 
portable music player, DVD player, or on your computer. Use the new 
Beat Matching feature to create mixes your friends will envy. Select the 
Create Music Disc Projects task.

■ Transfer audiobooks from audio CDs or the Internet to an iPod, 
iPhone, or other portable device with just a few clicks. Select the 
Create Audiobooks task.

■ Create a DVD Music Disc with up to 50 hours of music using tracks 
from your computer or an audio disc. Choose from professionally 
designed styles or use your own background image, then burn your 
project to a disc and play on your computer or set-top player. Select the 
Create DVD Music Discs task.

■ Create digital audio files from your old LPs and tapes in just a few 
simple steps. You can then clean and enhance your audio files, burn 
them to an audio CD, or use them in your Creator projects. Select the 
Digitize LPs and Tapes task.

For more information, see Chapter 6, Creating music discs, on page 97.
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Working with photos
You will find links to these tasks by selecting the Photo project tab:

■ Enhance, edit, and share your digital photos. Automatically adjust 
the exposure, saturation, and sharpness of photos. Fix common 
problems such as red eye. Select the Edit Photos task.

■ Create personalized calendars, greeting cards, and collages 
using your own photos. You can also create photo slideshows to share 
with others. Select the Create Projects task.

■ Enhance several photos at once using AutoFix and other photo 
tools. Rename or convert groups of photos to a different format. Select 
the Enhance Multiple Photos task.

■ Create a dramatic panorama by combining several photos into one. 
Select the Create Panoramas task.

■ E-mail your photos and photo projects to friends and family. Select 
the Email task.

■ Create a high-resolution photo slideshow in just a few clicks, 
including background audio and Pan and Zoom effects. Select the 
Create Slideshow task.

For more information, see Chapter 7, Working with photo projects, on 
page 117, and Chapter 8, Printing and sharing media files, on page 135.

Working with video
You will find links to these tasks by selecting the Video-Movies project tab:

■ Make backup copies of personal DVD discs so you can store the 
originals for safekeeping. Convert video files to formats that can be 
played on a wide range of portable devices. Select the 
Copy or Convert Video task.

■ Play movie discs using the ultimate digital theater. Creator delivers 
the absolute highest quality video playback available for your PC and 
packs all of its powerful features into an extremely easy-to-use and 
intuitive user-interface. If your movie player doesn’t include Blu-ray 
support, don’t worry—it’s available as an inexpensive upgrade. Select 
the Play Movies task.
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■ Create professional-looking video productions that combine your 
home videos and photos with audio, transitions, and special effects. 
Select the Edit Video—Advanced task.

■ Make great looking video productions in a few easy steps. Select 
the Create DVDs task.

■ Create multimedia stories on DVD to share with family and friends. 
Capture and mix photos and video, include narration or a favorite 
sound track, create your own professional-looking menus, add 
transitions and animated backgrounds, and burn to DVD, Video CD, 
or Super VCD. Some versions even let you author Blu-ray movie discs. 
Select the Create DVDs—Advanced task.

For more information, see Chapter 14, Creating advanced video discs 
with menus, on page 205.

Copy and data projects
You will find links to these tasks by selecting the Data-Copy project tab:

■ Copy files to a CD, DVD, or Blu-ray Disc. Select the Burn Data Disc 
task.

■ Duplicate an entire disc. Select the Copy Disc task.

■ Create data CDs and DVDs, and to archive large projects to multiple 
discs. Create advanced format and bootable discs, and more. In 
addition, you can choose to encrypt the files on the disc so that the 
files can only be accessed by someone entering a password that you 
select. Select the Burn Data Disc—Advanced task.

■ Backup the files on your computer to a wide range of storage 
devices including discs, external hard drives, and flash drives. 
Select the Backup Files task.

Note  The Backup Files task is not available in all version of 
Roxio Creator.
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Importing and organizing media files
You will find links to these tasks on more than one project tab:

■ Import photos and video files to your computer from your digital 
camera, mobile phone, or camcorder. Select the 
Import Photos or Capture Video tasks.

■ View and manage your media files in folders, and to organize them 
into personalized albums. Find files quickly by browsing or searching, 
and burn your files to a disc. Select the Browse and Manage Media task.

■ Share your media files with friends and family over your home 
network. Select the Browse and Manage Media task.

■ Transfer files to your wireless devices, and upload video files to the 
Internet. Select the Browse and Manage Media task.

For more information, see Chapter 10, Making advanced data discs, on 
page 171.

Creating labels and disc inserts
You will find links to this tasks on all of the project tabs:

■ Make personalized disc labels and jewel case covers. Choose from 
dozens of professional designs, or create your own. Select the 
Create Labels task.

Don’t forget the Tools menu
■ Erase or finalize a disc, get disc information, and keep track of 

what’s on your discs. All of these tasks can be started from the Tools 
menu. This is also where you’ll go to create virtual disc drives.
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Completing a typical task
Each task in Creator is a little different. Some are incredibly simple. Others 
take a little time to master. To help you get started, let’s walk though one of 
the most useful projects—creating a disc that contains files copied from 
your computer.

1 Open Creator by double-clicking the icon that was placed on your 
computer desktop during installation. In most cases, the main Creator 
application window opens with the Home category selected. It will 
look something like this:

The Home window includes links to frequently used tasks.

On the left side of the window, you will see the names of several 
project categories. Since we are going to be making a data disc, click 
the Data-Copy category.

The application window changes and displays a set of tasks that are 
related to protecting or copying the valuable files stored on your 
computer.
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2 When you are ready, click Burn Data Disc.

A longer description appears when you hold the cursor over a 
task link.

The application window changes again. It now displays everything you 
need to set up your project and burn a disc. 

Burn Data Disc project window

As you can see, the Burn Data Disc project is built into the main 
Creator application window. Some projects are built into the main 
window; others open in a separate window. Many components that 
open in separate windows have names you may know: MyDVD, 
VideoWave, CinePlayer. They are all part of your Creator suite.
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3 To begin a data disc project, insert a blank CD, DVD, or Blu-ray Disc 
into your computer’s disc drive. (The project also allows you to add 
files to an existing data disc, but to keep things simple for this project, 
use a blank disc.)

4 Use the Destination drop-down menu to select the drive holding your 
blank disc. If your computer only has one disc drive, it will be selected 
automatically.

Click the Destination menu and choose from the list of available 
drives.

5 Now you are going to add the files you want to copy to the project.

Click the Add button located at the top of the Burn Data Disc project 
window. Choose Files or Folder from the submenu.

Use the toolbar to open the Quick Scan panel, add files, name 
your disc, and delete files from a project.

A dialog window opens. Use it to select the files or folders you would 
like to add.

6 Near the Add button on the project window toolbar is the Disc Name 
text box. Enter a name for your disc, so it will be easy to recognize the 
next time you use it.

While you are using the project toolbar, notice that it includes some 
other useful features. The Quick Scan panel makes it easy to select files 
by category. To the right of the Disc Name text box is the Make 
Bootable button. Use it to create a bootable disk that can be used to 
start your computer if something should ever go wrong with the 
Windows operating system.
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Before burning your disc, look along the bottom of the project 
window. Here you will find several project status indicators. The 
information presented varies from project to project and is updated 
when you change discs or destination drives.

Project information is displayed along the bottom of the window.

In this case, the indicator shows the project size, the type of disc in the 
drive, and the available disc space.

7 Now you are ready to burn a disc. To begin, click the large green 
button on the bottom right corner of the project window. A progress 
indicator appears, and your files are copied onto the disc.

The progress indicator shows a burn nearing the halfway point.

You don’t have to wait for this project to finish before starting one of 
the other projects in your suite. But you can only have one project of 
each type running at a time.

When the project is finished, remove your disc and click Finish. If you 
would like to save this project so the same file set can be easily burned 
in the future, click on the File menu and select Save.
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Where to find more information
This guide provides an overview of Creator. For detailed information about 
how to use all of the features of Creator, see the online Help described 
below.

Online Help
Most Creator components have an extensive, searchable Help Center. Each 
Help Center includes step-by-step procedures and answers to frequently 
asked questions. 

To access the Help Center, choose Help > Component Help Center. To 
view context-sensitive Help for the activity you are currently doing, 
press F1.

Tutorials
Creator includes tutorials to help you quickly become familiar with many of 
its key features. Each tutorial includes tips and step-by-step instructions to 
help you get started creating exciting digital media projects. 

Choose any of the following ways to view a tutorial:
■ From Creator Home, choose Help > Tutorial, and then select the 

tutorial you want to view.

■ Visit the Roxio support Web site, located at http://support.roxio.com, 
for helpful “how-to” tutorials and other product information. 

Roxio online support
If you can’t find the answers you are looking for in the online Help or this 
guide, you can get the most current information from our Web site.

You can access the Roxio Web site in any of these ways:
■ Launch your Web browser and go to http://support.roxio.com.
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Creator support options

Unlimited self-help options
Roxio provides a variety of self help tools, including our virtual agent, a 
searchable knowledge base of support articles with troubleshooting tips, 
and tutorials that can help you get the most out of your Roxio products. 

Be sure to visit the Roxio Support Web site before you contact us by phone 
or e-mail—you’ll find answers to most of your questions at 
http://support.roxio.com.

Alternate support options
Alternate support options such as e-mail or telephone support may be 
available on a limited or paid basis for your Roxio product. Please visit our 
Web site at http://support.roxio.com to find out what options are available 
for your product.

Before you contact Roxio
If you can’t find the help you’re looking for in the online Help or on Roxio’s 
support Web site, you may decide to contact us by e-mail or phone. Before 
you do, visit http://support.roxio.com to view helpful steps that you can 
take before you contact us.

Contacting Roxio
Log in to our Customer Web portal to submit a request for assistance or to 
find support contact information for your location. You can find the 
customer Web portal at http://selfserve.roxio.com. 
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Welcome to Media Import
Using Media Import, you can copy or record digital photos, video, and 
movie titles to your computer with one easy-to-use interface. 

Media Import allows you to copy or record from wide range of media 
storage devices (such as digital cameras, memory cards, flash memory 
drives, scanners, and discs), and source devices (such as VCRs and Web 
cameras).

Once you have transferred your media files to your computer, you can use 
them in any other Roxio digital media component.

This guide describes how to:

■ Import photos

You can transfer photos from digital cameras and scanners, data discs, 
and other removable media storage devices. Media Import supports 
both Windows Image Acquisition (WIA) and TWAIN protocols.

■ Import video

You can copy video (live and saved video footage, as well as 
unencrypted movie titles) from digital video (DV), high definition 
(HD), digital, and Web cameras, video equipment (such as VCRs or 
TV tuners) attached to your computer, and discs.
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Starting Media Import
When you connect a device or insert a disc containing media files, 
Microsoft Windows prompts you to select the application to use:

Note  This dialog does not appear if you have already selected an 
application to use with this device, and if you selected Always do 
the selected action.

If this dialog appears, select the “using Media Import” option. If you always 
want to use Media Import with this device or disc type, select Always do 
the selected action.

You can also open Media Import from Creator’s main application window 
by doing one of the following: 

■ Select the Video-Movies task category and choose Capture Video.

or

■ Select the Photo task category and choose Import Photos.
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Getting to know the Media Import window
The Media Import Home page provides an easy-to-use interface with which 
you can transfer media files to your computer from any attached digital 
media devices.

Media type buttons
At the top of the Media Import window are buttons that allow you to 
choose the type of media to import (Photo or Video). When you click one 
of these buttons, you see the Home page for that media type. The following 
illustration shows the Photo Import Home page.

Device drop-down list
At the top of each media Home page is a drop-down list containing the 
devices from which you can import files. With some exceptions (see Devices 
appearing when no external device is connected on page 37), the list only 
includes devices that are currently connected to your computer and that 
contain media files in formats supported by Media Import.

Media Type
buttons

Device drop-
down list

Media- and
device-specific

dialog
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Media- and device-specific dialog
When you select a device from the drop-down list, the left side of the Media 
Import window shows a dialog specific to that device type. (The preceding 
illustration shows a dialog to import photos from a CD.)

Import Bin
The Import Bin (not shown) is on the right side of the Media Import 
window. It contains files imported in this session (that is, since you started 
the component).

Devices appearing when no external device is 
connected
The Device drop-down list always contains entries for the following 
devices, even if no external media device is connected. 

■ video capture card: If a video capture card is installed on your 
computer, the video capture card appears in the Device list on the 
Video Home page. Media Import cannot tell whether an analog video 
device (such as a VCR or TV tuner) is connected to the video capture 
card. 

■ TWAIN devices: If a TWAIN device is installed on your computer, 
the Device list includes the device, even if the device is not connected.
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Overview of importing media files
This section gives an overview of the import process, using photos or video 
files on a digital camera as an example. The procedures for importing 
different types of media files from other sources are similar, but may not be 
exactly the same as the procedure given in this chapter. For more 
information about importing media files from these other devices, see the 
Media Import Help Center.

Importing photos or video files from a digital camera 
(WIA) 
Use this procedure to import photos using a WIA interface. If your digital 
camera supports a movie or video feature, you can also use this procedure 
to import video files. 

Note  Digital cameras store video using common video file 
formats, such as MPEG or MOV.

To import photos from a camera (WIA): 

1 Connect the camera to your computer following the instructions that 
came with the camera.

Note  If you have not already chosen an application to use with 
the camera, you are prompted to do so. Select Media Import and 
click OK. 

If Media Import is open on your computer, continue with the next 
step.

If Media Import is not open, it opens and the Photo Import Home 
page appears. Skip to Step 4.

2 On the Media Import Home page, click Photo.

3 On the Photo Import Home page, in the Device drop-down list, select 
your camera.
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Tip:  If your camera supports both the WIA and TWAIN interfaces, 
the Device list contains an entry for each interface. Hover the mouse 
over the entries to identify the one for the WIA interface.

4 Select the digital media files to import. To select or deselect individual 
files, press and hold Ctrl while you click the files.

Note  For some types of video camera, photos and videos are 
stored in different folders. You can only import photos or videos 
from one folder at a time. If your camera stores photos and 
videos in multiple folders, you must import the photos or video 
from each folder separately.

5 Select the check box for each location in which you want to save the 
media files. 

6 In the Rename files text box, enter a name for the selected files.

Media Import uses the text entered in this box as the beginning of the 
file name for each imported media file. For example, if you are 
importing multiple photos and enter “PhotoDec15,” the imported files 
are named “PhotoDec15 00000,” “PhotoDec15 00001,” and so on.

7 Optional: Select the Delete files from device after transfer check 
box to delete the photos from the camera after the import process is 
complete.

8 To burn the files to disc after importing them, select Burn to disc.

9 Click Import Now.

Media Import imports the digital media files to the selected folder.

Note  This chapter provides an overview of Media Import and 
the import process, using photos as an example. For detailed 
information about how to use all of the features of Media Import, 
see the Media Import Help Center.
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About Media Manager
Your media files—photos, video clips, music tracks, and Roxio projects—
come from many different sources, and can be stored in various locations 
on your computer. They can also be stored on network drives, on 
removable storage devices, such as CD or DVD discs, or on compatible 
wireless devices, such as mobile phones. 

Media Manager provides two tools for organizing and viewing your media 
files:

■ Smart Views: Media Manager automatically groups your media files 
based on common characteristics, such as media type, project type 
(PhotoSuite, MyDVD, and so on), keyword, and date (last week, last 
month, and so on). A media file can belong to multiple Smart Views. 
You can also create custom Smart Views based on searches.

■ My Albums: You can group media files with a common theme into 
albums. As with Smart Views, a media file can belong to multiple 
albums. When you move a file into an album, the physical location of 
the file does not change. 

For example, you might have a photograph of your children at the zoo 
in the summer of 2008. You can create the following albums, and 
include that photograph in all of them: Kids, Summer Vacation 2008, 
Zoo.

If you’ve already organized your photos and videos into folders, Media 
Manager automatically creates an album for each folder. When you 
add a photo or video to one of these folders, Media Manager 
automatically adds it to your album.

Starting Media Manager

To open Media Manager: 
■ From Creator’s main application window, select Browse and Manage 

Media from one of these task categories: Video-Movies, Music-Audio, 
or Photo.
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What you can do with Media Manager
You can use Media Manager to:

■ Browse through and organize your photos, video clips, music tracks, 
and Roxio projects.

For more information, see Working with albums on page 49.

■ Preview, rename and delete your media files, as well as assign keywords 
and ratings.

For more information, see Working with media files on page 55.

■ Find media files quickly and easily by searching on file names, 
keywords, comments, or file type.

For more information, see the Media Manager Help Center.

■ Make minor touchups to photos, extract images and audio from 
videos, and create slideshows and panoramas. You can also open your 
media files in other Roxio components to add them to projects or 
make more extensive changes.

For more information, see the Media Manager Help Center.

■ Share your media files with friends and family. 

For more information, see Chapter 8, Printing and sharing media files.

Supported file formats
Media Manager supports all of the photo, video, and audio file formats 
supported by the Roxio components. Only files in supported formats are 
visible in Media Manager.

Monitoring new media files
Media Manager can automatically monitor your computer for new media 
files. You can choose the folders to be monitored, and you can stop and 
start monitoring whenever you wish.

To open the Monitored Folder Settings dialog box:
■ Choose Tools > Select Monitored Folders.

The Monitored Folder Settings dialog box appears.
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Getting to know the Media Manager 
window
The Media Manager window provides an easy-to-use interface from which 
you can organize your media files.

The following illustration identifies the parts of the window that are 
common across all views. 

My Media tab

Folders tab

My MediaSpace tab

My Devices tab

Menu Bar

Options BarTask Bar

Browse area
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Media Manager offers the following views to help you easily access and 
organize the media files on your computer and connected devices:

■ My Media

This view shows your Smart Views, playlists, and albums. 

Smart Views are media file groupings automatically created and 
maintained by Media Manager, based on characteristics such as media 
type, keyword, and date, so you can find your media files more easily. 

Playlists are groups of audio files that you create and manage yourself. 
You can use playlists to group files you want to listen to, burn to a CD, 
or sync to an audio device. 

Albums are media file groupings that you create and manage yourself. 
You can use albums to group media files from vacations, events, or 
special occasions. If you’ve already organized your photos and videos 
into folders, Media Manager automatically creates an album for each 
folder. When you add a photo or video to one of these folders, Media 
Manager automatically adds it to your album.

For more information on using the My Media view, see Working with 
My Media on page 46.

■ Folders

Your files are organized into folders for easy access. The Folders view 
shows you the media files stored in Windows folders on your 
computer storage devices, including the hard disk and removable 
storage devices such as CD or DVD discs. 

The Folders view is very similar to Windows Explorer, both in how it 
looks and in how you use it, except that you only see media files 
supported by Roxio products.

For more information, see Working with folders on page 54.

■ My MediaSpace

Media Manager enables you to view and share your digital media with 
other computers on your home network, provided that the computers 
on your home network support the Universal Plug and Play (UPnP) 
networking technology. For more information, see Using MediaSpace 
to share media on page 148.
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■ My Devices

Using Media Manager, you can view digital media on compatible 
wireless devices, such as mobile phones. The My Devices view shows 
you all detected devices, and allows you to browse the media files on 
these devices.

For more information, see Sharing media files with wireless devices on 
page 144.

Working with My Media
The My Media view shows your Smart Views and albums.

Smart Views are media file groupings automatically created and maintained 
by Media Manager, based on common characteristics such as media type, 
date, or keyword. You can also create Smart Views from your search queries, 
or from existing Smart Views. 

Albums are media file groupings that you create and manage yourself. You 
can use albums to group media files from vacations, events, or special 
occasions. If you’ve already organized your photos and videos into folders, 
Media Manager automatically creates an album for each folder. When you 
add a photo or video to one of these folders, Media Manager automatically 
adds it to your album.

A single media file can be included in multiple Smart Views and albums. 
Moving media files from one album or Smart View to another does not 
affect the files’ physical location on the disk. When you remove media files 
from Smart Views or albums, the media files are not physically deleted from 
your disk.

You can remove a media file from a Smart View, which removes the file 
from all other Smart Views to which it belongs. (The files are not removed 
from the Windows file system.)

You can also rename files within a Smart View, which renames the file in all 
other views to which it belongs, as well as in the Windows file system. 

You cannot delete, rename, or move Smart Views.
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Note  Media Manager cannot find files that are renamed, moved, 
or deleted within Windows Explorer. If you disconnect or remove 
a storage device, such as a CD or DVD disc, files on the device 
will not be found.

For information on locating missing files, see Finding missing 
media files on page 58.

Browsing My Media
In the My Media view, you can browse the following groupings:

All Media
This Smart View shows you all media files detected by Media Manager. Use 
this view to search for files if you are not sure which views they belong to, or 
if you want to browse all of your media files.

All Photos
This Smart View allows you to browse your photos. Photos are further 
grouped by date, keyword, and rating, and you can see which photos have 
been recently imported or used, or have not yet been backed up.

All Videos
This Smart View allows you to browse your video files. It provides views for 
recently used and imported video files, and organizes your videos by 
format. In addition, a Not Protected view shows the video files that do not 
have Digital Rights Management (DRM) restrictions. 

All Music
This Smart View allows you to browse your audio files quickly and easily. It 
contains views common to all media types, such as date, keyword, rating, 
and backup status, as well as music-specific views, such as album, artist, 
and genre. In addition, a Not Protected view shows the music files that do 
not have Digital Rights Management (DRM) restrictions. 
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All Projects
This Smart View allows you to browse your Roxio projects. Projects are 
further grouped based on the Roxio component used to create them. The 
Smart View contains views for recently used and imported project files.

My Views
This Smart View contains your custom Smart Views (for example, Smart 
Views created from search queries). For example, you can save photos 
assigned the keyword “Birthday” as a custom Smart View named “Birthday 
Pics”.

My Playlists
This Smart View stores any playlists you have created.

My Synced Devices
This Smart View contains all of the portable devices (such as mobile 
phones) that you have synchronized with your computer. 

My Albums
This grouping stores albums created automatically by Media Manager 
(based on Windows folders), as well as any albums you created yourself.
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Working with albums

Creating new albums
You can create a new album in one of the following ways:

■ Create a new, empty, album.

■ Use the Albums button to select files, create an album, and add the 
selected files to the new album, all in one step. 

■ Drag files from Windows Explorer into a new album.

You can also create a new album based on search results.

To create a new, empty, album:

1 On the Task Bar, click Albums, and choose New Album.

A new album appears, with the default name, “New Album,” selected.

2 Type a new name for the album, and then press Enter.

To create a new album for selected files with the Albums button:

1 Select the files you want to put into the new album.

2 On the Task Bar, click Albums, and choose Add selection to new 
Album.

Media Manager prompts for the name of the new album.

3 Type the album name and click Yes.

Media Manager creates a new album, and adds the selected files to it.

To create a new album for files dragged from Windows Explorer:

1 In Windows Explorer, browse to and select the files you want to put 
into the new album.

2 On the Task Bar, click Split View.

3 In the Browse area at the bottom of the window, click My Media.

4 Select either All Albums or My Albums.

5 Drag the files into the Browse area in the bottom of the window.

Media Manager prompts for the name of the new album.
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6 Type the album name and click Yes.

Media Manager creates a new album, and adds the selected files to it.

Adding media files to albums
You can add media files to albums in several different ways.

To add media files to an existing album using the Albums button:

1 Select the media files you want to add to an album.

2 On the Task Bar, click Albums and choose Add selection to Album.

3 Browse to the album to which you want to add the files, and click OK.

To add media files to a new album using the Albums button:

1 Select the media files you want to add to an album.

2 On the Task Bar, click Albums and choose Add selection to new 
Album.

Media Manager prompts for the name of the new album.

3 Type the name of the new album, and click Yes.

To add media files to an album using the Split View:

1 On the Task Bar, click Split View.

A new pane opens at the bottom of the window, showing the My 
Media view.

2 In the bottom part of the window, browse to the album to which you 
want to add files.

3 In the top part of the window, browse to and select the files you want 
to add to the album. 

4 Drag the files to the bottom right pane to add them to the album.

5 Repeat Step 3 and Step 4 until you are finished adding files to the 
album.
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To add media files to albums using Windows Explorer:

1 If you are not in the My Media view, in the Browse area, click My 
Media.

2 In the Browse area, select the album to which you want to add media 
files.

3 Open Windows Explorer, and position Windows Explorer and Media 
Manager windows so you can see them both.

4 In Windows Explorer, select the media files you want to add to the 
album.

Tip:  To select more than one file at a time, press and hold Ctrl while 
you select the media files or folders.

5 Drag the files and folders into the album in Media Manager and 
release the mouse button.

The files are added to the album.

Moving or copying media files from one album to 
another
Follow this procedure to move or copy media files between albums. You can 
copy or move an entire album and its contents into another album.

When you copy or move a media file to an album, Media Manager does not 
actually create another copy of the file on your computer system, and the 
location of the file on your computer does not change. However, the file is 
referenced by a new album.

To move or copy media files between albums:

1 If you are not in the My Media view, in the Browse area, click My 
Media.

2 In the Browse area, click the album containing the albums or media 
files you want to move or copy.

3 Select the media files or albums that you want to move or copy.

Tip:  To select more than one file at a time, press and hold Ctrl while 
you select the files. 
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4 To copy the media files to the clipboard, right-click and choose Copy.

To move the media files to the clipboard, right-click and choose Cut.

5 In the Browse area, select the album to which you want to move or 
copy the media files.

6 In the album, right-click and choose Paste.

Setting the thumbnail for an album
Follow this procedure to use a photo or video file thumbnail as the 
thumbnail for an album.

To select the photo or video file to be used as the thumbnail for an 
album:

1 If you are not in the My Media view, in the Browse area, click My 
Media.

2 In the Browse area, click the album containing the photo or video file 
you want to use as a thumbnail.

3 Right-click the photo or video file, and choose Set As Album 
Thumbnail.
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Working with playlists
With Media Manager, you can easily create and manage playlists.

To create a new playlist:

1 In the Browse area at the top left of the window, click My Media to 
display the My Media view.

2 In the Browse area, click My Playlists.

3 Click Create a New Playlist.

4 Type a name for the new playlist. 

The Contents area in the top right part of the window shows the 
contents of the new playlist.

To add audio files to a playlist:

1 In the Browse area at the top left of the window, browse to and select 
the playlist to which you want to add audio files.

2 In the bottom part of the window, browse to and select the audio files 
you want to add to the playlist.

3 Drag the audio files into the Content area (the top right area of the 
window) for the new playlist.

Note  To rearrange the files in your playlist, just drag them to the 
desired location.

To delete a playlist:

1 In the Browse area, browse to the playlist you want to delete.

2 Click Delete Selected Playlist.

Media Manager prompts for confirmation.

3 Click Yes.
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Working with folders
The Folders view in Media Manager is similar to Windows Explorer, except 
that you only see media files supported by Roxio products. 

In the Folders view, you can browse the contents of the folders on your 
computer, and drag and drop media files between folders. You can also 
create folders, and rename or delete folders or the files within them. 

Creating new folders

To create a new folder:

1 If you are not in the Folders view, in the Browse area, click Folders.

2 In the Browse area, browse to the folder in which you want to create 
the new folder.

For example, to create a new folder inside the My Pictures folder, select 
My Pictures.

3 In the Browse area, click Create a New Folder.

A new folder appears, with the default name, “New Folder,” selected.

4 Type a new name for the folder, and then press Enter.
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Working with media files
Media Manager makes it easy to organize and manage your media files. You 
can rename files and delete them from albums or Smart Views, update or 
sort files in albums and Smart Views, and copy, move, or delete files from 
albums. You can assign keywords and comments to files, to help you when 
you are searching for media files.

You can view media files in a Preview window or as a full-screen 
QuickShow. 

This chapter gives an overview of managing your media files. For more 
information, see the Media Manager Help Center.

Selecting media files

To select media files:

1 Browse to the media files using one of the following views:

■ Click My Media to browse your Smart Views and albums. Smart 

Views are media file groupings created and maintained 

automatically by Media Manager, based on characteristics such as 

media type and date. Albums are media file groupings you create 

and manage yourself.

■ Click Folders to browse files in the Windows folders on your 

computer.

■ Click My MediaSpace (UPnP) to browse files stored on your 

home network.

■ Click My Devices to browse files on mobile phones and other 

compatible devices detected by your computer.

2 Click the desired file.

Tip:  To select more than one file at a time, press and hold Ctrl while 
you click the files.
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Previewing media files
Using Media Manager, you can view media files in the preview window. You 
can also view photo files as a QuickShow. For information on how to 
preview your media files, see Viewing media files in a preview window. For 
information on how to view a QuickShow, see Viewing media files in 
QuickShows on page 57.

Viewing media files in a preview window
Follow this procedure to view your photos, listen to your sound tracks, or 
watch your videos. You can preview media files in any of the views, as well 
as in the Search Results area.

When previewing photos, you can browse through the files using the 
Previous and Next buttons. 

Note  In the Preview window, you can quickly fix and enhance 
your photo, video, and audio files. For more information, in the 
Preview window, click Help.

When previewing video files, you can view them in place, or you can open a 
larger preview window.

To preview photos:
■ Select a photo file and, on the Task Bar, click Preview Selected 

Item(s).

To preview a video, choose one of these methods:
■ To preview the video in place, on the video thumbnail, click Play.

■ To preview the video in a larger window, double-click the video 
thumbnail. 

A video Preview window opens. In this window, you can use the 
playback controls, or use the slider to move the playback cursor to the 
desired location in the video file.

You can also extract images or audio and detect scenes. For more 
information, see the Media Manager Help Center.
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To preview an audio file, choose one of these methods:
■ On the audio thumbnail, click Play.

■ Double-click the audio thumbnail. 

An audio Preview window opens. From this window, you can use the 
playback controls (Go to Start, Rewind, Play/Pause, Fast Forward, and 
Go To End). You can also use the slider to move the playback cursor to 
the desired location in the audio file.

Viewing media files in QuickShows
A QuickShow displays a view of all the selected media files, one after the 
other. Each photo displays in turn for five seconds. You can change the 
display time by selecting Tools > Options, and changing the QuickShow 
settings. Press the Help button on the Options dialog box for information 
on setting the QuickShow options.

If the collection contains audio or video files, each file plays one after the 
other.

To view a QuickShow:

1 In the Browse area, select the view containing the items you want to 
view as a QuickShow.

2 Select the media files you wish to view as a QuickShow.

3 On the Task Bar, click QuickShow.

The QuickShow window opens in full screen mode and the media files 
play in order.

4 To rotate a photo in the QuickShow, follow these steps:

a Move or click the mouse.

The QuickShow toolbar appears. 

b Click Rotate Counter Clockwise or Rotate Clockwise.
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Finding missing media files

Why are media files missing?
Files might be missing if 

■ you move, delete, or rename them in Windows Explorer

■ they are on a removable medium, such as a CD, that has been removed

■ they are on a network drive to which your computer is not connected

When a file becomes unavailable for any of these reasons, the reference to 
the file remains in the collection, but you will not be able to do certain 
tasks, such as preview the file or burn it to disc. 

When you try to access the file, the Cannot Find Required Files dialog box 
appears stating which file is unavailable, and prompts you locate or skip it.

Locating missing media files
Follow this procedure to locate missing media files.

To locate missing media files:

1 Optional: In the Cannot Find Required Files dialog box, click Show 
Files to see the list of missing media files or Hide Files if you do not 
want to view the list.

2 Choose one of the following ways to locate the media files:

■ If the missing media files are on a CD or DVD, insert the disc into 

the disc drive, and then click Retry.

■ If all of the listed files still have the same names but have been 

moved to a new folder, click Browse, locate the folder in which 

the files are stored, and then click OK.

■ If the missing media files have been renamed, or if individual files 

have been moved to different folders, select one file at a time from 

the Required Files list, and then click Locate File to browse to the 

file. Repeat for each file.

If Media Manager finds all of the missing media files on the disc or in 
the folder, then the Cannot Find Required Files dialog box closes.
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If Media Manager finds some of the missing media files, they are 
removed from the missing files list. Repeat this step to locate the rest of 
the files.

3 If you want to continue the task that you were starting before the 
Missing Files dialog box appeared without finding the missing media 
files, click Skip Rest.

You can skip one group of files at a time by clicking Skip. For example, 
you can skip all the files missing from a certain CD, and move on to 
the next group of missing files.

The Missing Files dialog closes and you can continue with your task. 
Some media files will not be available for the task. For example, if you 
are burning files to disc, the missing files will not be burned.
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Importing audio CDs
The Multiple Audio CD Ripper is an assistant you can use to quickly rip 
audio tracks from audio CDs and transfer them to a portable device, such 
as an iPod, PSP, MP3 player, or WMA player.

To open Multiple Audio CD Ripper: 
■ From Creator’s main application window, select the Music-Audio task 

category and choose Rip - Advanced.

To import and transfer files, follow these steps:

1 Insert the discs you want to import.

Note  If you have multiple disc drives, you can insert a disc in 
each one.

2 To change the import settings, including the destination location and 
file format, click Settings. 

3 Click Start.

The Assistant begins importing audio tracks. After importing all of the 
tracks from the disc, it ejects the disc. If you have more than one drive 
with audio CDs inserted, it automatically begins importing from the 
next drive. 

Tip:  To stop the import at any time, click Stop. 

Note  If an error occurs during the import, an error message 
displays. You can choose to try to import the track again, skip the 
problem track and continue with the next, skip all problem 
tracks, or cancel the import.

4 To import another disc, insert it in the drawer. The import resumes.

5 When you are finished importing discs, click Done.
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6 Optional: By default, the assistant automatically identifies CDs and 
tags songs. To view or modify the tags, or to automatically tag 
unidentified tracks, click Edit Audio Tags.

Tip:  For more information, click Help on the Edit Audio Tags dialog 
box.

7 To output the tracks to a portable device, continue with these steps:

a In the Imported Tracks list, use the Move Up and Move Down 
buttons to arrange the tracks in the desired sequence.

b Check the boxes beside the tracks you want to transfer.

c Click Output To and choose Portable Device.

d In the Select portable device box, select the device to which you 
want to copy the tracks.

e If the songs are not in the correct format for the destination 
device, select Force-convert to preferred audio format before 
transfer, and select the desired format from the drop-down list.

f To start the transfer, click Send.

8 To burn the tracks to an audio CD:

a In the Imported Tracks list, use the Move Up and Move Down 
buttons to arrange the tracks in the desired sequence.

b Click Output To and select Audio CD.

c Select the tracks you want to burn.

d Click Burn.

9 When you are finished, click Finish.
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Recording from an audio input device
Easy Audio Capture is an assistant you can use to quickly record audio from 
Internet radio and other sources, using a connection from your audio 
equipment to your computer’s sound input. 

To open Easy Audio Capture: 
■ From Creator’s main application window, select the Music-Audio task 

category and choose Capture Audio from Sound Card.

You can use Easy Audio Capture in two modes: Full mode and Mini mode. 
To switch between modes, use the Switch to Mini Mode and Switch to Full 
Mode buttons:

Using Easy Audio Capture in Full mode

To record audio in Full mode:

1 Set the following options, as required:

■ Capture From: Select your sound card from the list.

■ Input (Windows XP only): Select your audio input channel. For 

example, if you want to record from a Line in input, select Line 

In.

Note  Some sound card drivers do not support the “Stereo Mix” 
or “Wave Mix Out” Input option (the name of this option varies 
depending on the sound card). This option captures analog audio 
(such as Internet radio). If you need it, check to see if an updated 
device driver is available for your sound card. 

■ Recording Level: Drag the slider to increase or decrease the 

recording volume. If the volume is too high, distortion may 

Switch to Mini Mode

Switch to Full Mode
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result. If the volume is too low, the resulting sound may be less 

than optimal. 

■ Adjust the recording level so that the meter indicators light up 

only to the middle of the meter, passing the middle only 

occasionally. If all of the meter indicators stay lit persistently, the 

recording level has passed the zero dB clipping point, and is too 

“hot”. If this occurs, reduce your recording level.

■ If you want Easy Audio Capture to automatically find a recording 

level that does not clip, click Auto. Easy Audio Capture uses the 

highest possible recording level. If clipping occurs, Easy Audio 

Capture reduces the recording level. If no clipping occurs at this 

new recording level, this level is used.

■ Balance: Drag the slider to balance the audio level between the 

left and right speakers.

■ Capture settings: Select the output file format. The format you 

choose will depend on how you plan to use the audio clip. To 

define customized settings, including file format, encoder type, 

and bit rate, select Custom and click Options to define the 

custom settings.

■ Save to: Browse to the folder in which you want to save the new 

audio file. 

■ File name prefix: Enter a name for the audio files. Easy Audio 

Capture uses the text you enter to begin the file name for each 

recorded audio file. For example, if you are recording several 

audio files and enter “Audio,” the recorded files are named 

“Audio,” “Audio_1” and so on.

2 Start playing your source audio.

3 Click Record to start recording.

4 Optional: If you limited the recording time in the Capture Settings 
dialog box, and you want to extend the recording time, click + (beside 
Time left to record) for each additional minute that you want to 
record.
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5 When the analog source finishes playing, click Stop to stop recording. 

6 When you finish recording, click Close.

Using Easy Audio Capture in Mini mode

The Status display shows the amount of time left on the drive, the recording 
time elapsed, or the time left to record (if you have limited the recording 
time in the Options). To change between these displays, click the Status 
display area.

To record audio in mini mode:

1 Optional: Click Options and customize capture options, including 
file format, encoder type, bit rate, and file location.

2 Click Record to start recording.

3 Click Stop to stop recording. 

Record

Stop

Recording 
level

Edit Capture 
Settings

Switch to Full 
Mode Close

Status 
display
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Creating Audiobooks
Audiobook Creator enables you to easily convert an audiobook from an 
existing audio CD to iTunes, an iPod or other connected portable device, to 
an audiobook file on hard disk, or to an MP3 disc. Audiobook Creator can 
also convert public domain MP3 audiobooks that you have downloaded 
from the Internet.

To open Audiobook Creator: 
■ From Creator’s main application window, select the Music-Audio task 

category and choose Create Audiobooks.

Note  Audiobook Creator does not convert audiobooks from 
files that are copy-protected.

Getting to know the Audiobook Creator window
The Audiobook Creator task panes on the left-hand side include the 
following tasks:

■ Add Audiobook
■ Rip from CD: Select this task button to rip an audiobook from 

one or more audio CDs. When this task is selected, the Rip tracks 

from CD dialog opens. This dialog gives you access to several 

task-specific settings, including one that lets you determine 

where your files are saved.

■ Add files or folders: Select this task button to create an 

audiobook from audio files on your computer. 

Note  Tracks are ripped to a temporary location on your 
computer and are deleted when the application is closed.

■ Output to
■ iTunes (must already be installed): Select this option to output 

your audiobook to iTunes. All tracks will automatically be 
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combined into a single iTunes audiobook file (.m4b) with the 

following iTunes audiobook features:

■ each track will become its own chapter for easy navigation

■ pause/resume functionality

■ book cover art will be included and will be displayed in 

iTunes

■ iPod/iPhone (must be connected, and iTunes must already be 

installed): Select this option to output your audiobook to an iPod 

or iPhone. The following audiobook features will be included:

■ each track will become its own chapter for easy navigation

■ pause/resume functionality

■ book cover art will be included and will be displayed in 

iTunes

■ Other portable device (must be connected): Select this option 

to output your audiobook to a portable device.

■ MP3 disc: Select this option to output your audiobook to an 

MP3 disc. This option is especially useful if your source 

audiobook is on several CDs and you want to combine them onto 

a single disc in a compressed format. 

Note  MP3 disc playback requires a player that supports this 
format.

■ Playlist: Select this option to output your audiobook to a hard 

disk as a playlist that can be played back on your PC using a 

standard player, such as Windows Media Player. Or, send the 

playlist to a portable device at a later time. Audiobook Creator 

supports the following playlists:
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The Audiobook Creator window also contains the following features:

■ Toolbar

■ Undo/Redo: Use these buttons to undo or redo the last action 

taken.

■ Delete: Select the track(s) you want to delete, then click the 

Delete button.

■ Help: Opens the Audiobook Creator help file.

■ Settings: Use the Settings dialog to customize preferred audio 

quality and file format settings. File format is only valid if you 

Format output Description

.M3U ■ Standard audiobook playlist
■ Many players support chapter skipping since 

chapters are not merged
■ Some players do not support pause/resume of 

playlists when bookmarking is used

.WPL ■ Windows Media Player audiobook playlist
■ Many players support chapter skipping since 

chapters are not merged
■ Some players do not support pause/resume of 

playlists when bookmarking is used

.MP3 ■ Merged playlist
■ Chapter skipping is not supported
■ Most players support pause/resume of single 

files when bookmarking is used

Undo/Redo Delete Help

Settings
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output to a playlist, or to a portable device other than an iPod or 

iPhone. When outputting to iTunes, iPod or iPhone, the file 

format is automatically converted to iTunes audiobook format 

(.m4b). When outputting to an MP3 disc, the file format is 

automatically converted to .mp3.

■ Title: Use this text box to edit the audiobook’s title.

■ Author: Use this text box to edit the audiobook author’s name.

■ Change cover art: Select this option to locate and apply cover art to 
your audiobook. 

Tip:  Here’s another way to change cover art: Drag and drap image 
files from your computer desktop to the thumbnail.

Tip:  To crop white space around a cover art image, right-click the 
thumbnail and select Auto crop.

■ Remove cover art: Select this option to remove the cover art.

Tip:  To delete all tracks in your playlist, click the cover art image, then 
click the Delete button located on the toolbar.

Editing audio tags with the Audio Tag Editor 
The Audio Tag Editor allows you to associate the following information 
with your audio files:

You can enter this information manually, or you can search an online music 
database, using the MusicID feature. 

To open Audio Tag Editor: 
■ From Creator’s main application window, select the Music-Audio task 

category and choose Edit Song Information.

■ title ■ genre

■ artist ■ track number

■ album name ■ year

■ album artist ■ BPM (beats per minute)
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or

■ Click one of the links found within Creator’s other audio tasks.

To update track information automatically with the MusicID feature:

1 If you are editing tags for multiple tracks, select the tracks you want to 
change.

2 In Sound Editor, if you are editing tags for an audio clip that contains 
multiple tracks, and if you want to add or change information for only 
one track, select the track name in the Title drop-down list. Otherwise, 
you can edit all of the selected files together.

3 To search the online database for track information, click MusicID. 

The online database is searched for an entry that matches the selected 
tracks. The results of the search are listed in the status area. For a 
description of the statuses, click Help on the Edit Audio Tags dialog 
box.

4 If multiple matches are found, click the Multiple Matches link to 
select the information you want to use.

5 To use the information that was found in the music database, select the 
Use MusicID tags check box.

Tip:  You can apply the MusicID tags to some, but not all of the tracks. 
To do so, on the left side of the Audio Tag Editor window, select only 
the track(s) for which you want to use MusicID tags, and click 
MusicID. 

To use the original tags for any of the identified tracks, select the tracks 
and then click Reset or uncheck Use MusicID tags.

6 Depending on the application from which you invoke the Edit Audio 
Tags dialog box, the following options might be available:

■ Embed or replace tags inside the audio files (if supported by 
the format): Saves track information with the audio file. If you 

do not select this option, the audio tag information will be 

associated with the track in this project only. (This option is only 

available for file formats that support metadata.)
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7 To close the dialog box, click Done.

To edit track information manually:

1 In the tracks list, select the tracks for which you want to add or change 
information.

2 In Sound Editor, if you are editing tags for an audio clip that contains 
multiple tracks, and if you want to add or change information for only 
one track, select the track name in the Title drop-down list. Otherwise, 
you can edit all of the selected files together.

3 Select the text you want to change and then type new text.

4 Depending on the application from which you invoke the Edit Audio 
Tags dialog box, the following options might be available:

■ Embed or replace tags inside the audio files (if supported by 
the format): Saves track information with the audio file. If you 

do not select this option, the audio tag information will be 

associated with the track in this project only. (This option is only 

available for file formats that support metadata.)

5 To close the dialog box, click Done.
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Converting, renaming, and moving audio 
files
The Audio Converter is an assistant you can use to quickly perform these 
tasks:

■ convert audio files or audio tracks from one or more formats and 
sources (such as audio CD, unencrypted DVD-Video disc, hard disk, 
or iPod) to your preferred audio file format

■ automatically rename audio files based on audio tag information

■ move audio files or tracks from one location on your computer to 
another

■ transfer audio files or tracks to a portable device, such as an iPod, PSP, 
MP3 player, or WMA player

To open Audio Converter: 
■ From Creator’s main application window, select the Music-Audio task 

category and choose Batch Convert and Transfer.

Note  Protected audio files such as M4P or protected WMA files 
have restricted usage rights, and you may not be able to convert, 
move, rename, or transfer them.

Additionally, Some audio files are protected with digital rights 
management (DRM) and cannot be converted.
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Converting files

To convert audio files to a different audio file format, follow these 
steps:

1 Click Add Tracks and browse the CD, DVD, hard disk, or iPod, to 
select the audio files or tracks you want to convert.

Note  You may be able to add audio files from other portable 
devices, depending on the file and device type.

2 To update the audio tags for the selected files, click Edit Audio Tags. 
The Edit Audio Tags dialog box opens. Edit the audio tags (for more 
information, click Help on the Edit Audio Tags dialog box) and click 
Done to close the dialog box. 

3 Click Convert.

4 Select Keep original files to keep the original source files. 

Warning  If you do not select this option, the original files will be 
deleted.

5 In the Conversion settings box, choose the new audio file format. (For 
more options, click Edit.)

6 Optional: To ensure the loudest sound output possible without 
distortion, click Maximize volume.

7 To create a folder structure and file names based on audio tags (such as 
artist and album name), select Subfolder / file name structure, and 
choose the folder structure and file naming convention you want to 
use.

8 In the Target folder box, specify the location on the hard disk or 
network where you want to store the converted files.

9 Select what to do if a file with the same name already exists in a folder.

10 Click Convert.
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Renaming files

Note  Some audio files are protected with digital rights 
management (DRM) and cannot be renamed.

To rename audio files, follow these steps:

1 Click Add Tracks and browse the CD, DVD, hard disk, or iPod, to 
select the audio files or tracks you want to rename.

Note  You may be able to add audio files from other portable 
devices, depending on the file and device type.

2 Click Convert.

3 Unless you want to keep the original files, clear the Keep original files 
check box. 

4 In the Conversion settings box, select Keep original format.

5 Select Subfolder / file name structure.

6 From the drop-down list on the left, select Original folder.

7 From the drop-down lists on the right, select the file naming 
convention you want to use.

8 Select what to do if a file with the same name already exists in a folder.

9 Click Convert.
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Moving files

Note  Some audio files are protected with digital rights 
management (DRM) and cannot be moved.

To move audio files, follow these steps:

1 Click Add Tracks and browse the CD, DVD, hard disk, or iPod, to 
select the audio files or tracks you want to move.

Note  You may be able to add audio files from other portable 
devices, depending on the file and device type.

2 Click Convert.

3 Unless you want to keep the original files, clear Keep original files. 

Warning  The original files will be deleted.

4 In the Conversion settings box, select Keep original format.

5 Choose the subfolder structure to be used:

■ To keep the same folder structure, clear the Subfolder / file 
name structure check box.

■ To move the files to a folder structure based on audio tags (such 

as artist and album), select the Subfolder / file name structure 

check box. From the drop-down list on the left, select the desired 

folder structure. In the drop-down list in the middle, set the file 

naming convention to Original file name.

6 In the Target folder box, specify the location on the hard disk or 
network where you want to store the files.

7 Select what to do if a file with the same name already exists in a folder.

8 Click Convert.
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Transferring files to a portable device

Note  Some audio files are protected with digital rights 
management (DRM) and cannot be transferred to a portable 
device.

To transfer files to a portable device, follow these steps:

1 Click Add Tracks and browse the CD, DVD, hard disk, or iPod, to 
select the audio files or tracks you want to transfer.

Note  You may be able to add audio files from other portable 
devices, depending on the file and device type.

2 To update the audio tags for the selected files, click Edit Audio Tags. 
The Edit Audio Tags dialog box opens. Edit the audio tags (for more 
information, click Help on the Edit Audio Tags dialog box) and click 
Done to close the dialog box. 

3 Use the Move Up and Move Down buttons to arrange the tracks in 
the desired sequence.

Note  Some portable devices do not support the playback order.

4 Click Send to Portable.

5 In the Select portable device box, select the device to which you want 
to copy the tracks.

6 If the songs are not in the correct format for the destination device, 
select Force-convert to preferred audio format before transfer, 
and select the desired format from the drop-down list.

7 To start the transfer, click Send.

8 Click Close to exit the converter.
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Creating track lists using AutoMix
AutoMix automatically creates track lists for you by finding tracks that are 
similar to each other. You begin by selecting a track, or more than one track, 
to start with. Then let AutoMix search your music database for other songs 
that are similar. 

Note  This feature creates track lists by searching for tracks that 
have been identified by the online MusicID service. If a track on 
your computer is not found and included in the AutoMix, then it 
has not been identified. You must identify tracks before using 
AutoMix. 

To open AutoMix: 
■ From Creator’s main application window, select the Music-Audio task 

category and choose Create Playlists Automatically.

To create a track list using AutoMix:

1 Select a starting track:

■ If AutoMix is already open, click Add to select one or more tracks 

to start with. Once you’ve selected a starting track, click 

Continue.

■ If you are working in an audio project, select one or more tracks 

and choose Tools > AutoMix. 

Note  Only identified tracks can be used to create an AutoMix 
track list. If any of the starting tracks you select are not identified, 
you will be asked to identify them before continuing. 

The AutoMix dialog box opens with the results of the first AutoMix 
search. 

2 If you want to search again, and want to keep or exclude some or all of 
the original results, click the icon beside the song title. You can also 
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keep or exclude all of the tracks by clicking the icon beside the Title 
heading.

3 To search again, click Find Again.

4 Optional: For Limit results to, enter the maximum number of tracks, 
minutes, or megabytes to include in the track list (for example, 25 
tracks, 45 minutes, 20 megabytes).

5 When you are satisfied with the songs in the AutoMix, you can add 
them to the current project or create a playlist. The options that are 
available are different depending on whether you opened AutoMix 
from an audio project or not.

■ If you opened AutoMix from an audio project, choose one of the 

following options:

■ Select Add tracks to currently selected track list in 
project, and then click Add to Project.

■ Select Add tracks as a new track list. Enter a name for the 

track list, and then click Add to Project.

■ If you did not open AutoMix from an audio project, choose one 

of the following options:

■ To create a playlist of the tracks that you can use in audio 

players such as Windows Media Player, click Save as 
playlist. Enter a name for the playlist and choose the type of 

playlist that you want to create.

■ To send the track list to a portable device such as an MP3 

player, click Send to portable device.

■ To create a music disc that you can play on your computer 

or your home or car stereo, select Create music disc, and 

then select a disc format.
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Welcome to Sound Editor
Sound Editor lets you record, preview, and modify any supported and non-
copy-protected digital audio file format (including WAV and WMA). You 
can use Sound Editor to import (record) audio from analog sources, 
including LP records and tapes, then apply audio effects to improve and 
enhance your recorded audio. Finally, you can save your audio tracks for 
use in other Roxio projects or burn them directly to audio CD.

When working on a Sound Editor project, you can:

■ Add audio files stored on fixed or removable drives, copy audio tracks 
from CDs, or record audio from analog sources such as LP records and 
tapes. For more information, see About adding audio clips on page 86.

■ Edit your clips and choose from a wide range of effects to apply to 
either the entire project or a part of the project (for example, adjust 
the volume or balance, remove “crackling” sounds from audio files, or 
add dramatic effects to your music). For more information, see About 
editing and applying effects on page 88.

■ Export your clips and tracks into standard audio formats or quickly 
burn your music to disc (for enjoyment on your home or car stereo, or 
on a portable music device). For more information, see Completing 
Sound Editor projects on page 92.

To open Sound Editor: 
■ From Creator’s main application window, select the Music-Audio task 

category and choose Edit Audio.
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Getting to know the Sound Editor window
The Sound Editor window provides an easy-to-use interface for adding 
audio clips to your project, editing your audio clips (improving quality or 
applying effects), and exporting your audio to a file or burning it to a disc.

Task area Clip Editor Zoom Controls

Track 
Position

Volume
Mute/
Un-Mute

Enable/Disable
Repeat Mode

Playback 
Controls

Selection 
Length

Balance 
Controls
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Sound Editor project file format (.dmse)
Sound Editor projects are stored in DMSE format. The Sound Editor's 
project file stores:

■ references to the audio files included in the project

■ information about effects and changes applied to these audio files

■ information about how the audio files are organized into tracks and 
layers

Because changes to the audio files are stored separately from the files 
themselves, you can easily undo them. For example, if you apply an effect to 
a specific part of the waveform, you can remove that effect later. 

Note  When you save a Sound Editor project in another format, 
such as WAV, your edits are flattened and combined, and you can 
no longer undo changes.

DMSE files are not suitable for sharing, as they contain references to audio 
files, but not the audio files themselves. If you share a DMSE file with 
another user (who must also have Sound Editor), you must also share all 
referenced audio files, and the audio files must be in the same folder 
structure as they are on your computer.
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Getting started with Sound Editor projects
A Sound Editor project is a collection of the following components:

■ Audio clip: An audio file which contains a song, a part of a song, or a 
short repetitive sound, such as a drum beat. You can add audio clips 
from various sources to your Sound Editor project. For more 
information, see About adding audio clips on page 86.

■ Track: An audio clip or part of a clip. You can export a track as a track 
on an audio CD, or as an audio file. For more information, see 
Exporting sets of tracks or audio clips on page 94 or Burning tracks or 
clips to audio CDs on page 96.

Working with Sound Editor projects typically involves the following steps:

1 Add an audio clip to your project. For more information, see About 
adding audio clips on page 86.

2 Improve the quality of the audio clip and apply special effects using 
the Clip Editor. For more information, see About editing and applying 
effects on page 88.

3 Repeat Step 1 to Step 2 to add and enhance additional audio clips.

4 Add track separators so you can create an audio CD with multiple 
tracks, or so you can save your tracks as separate audio files. For more 
information, see Adding or deleting track separators on page 90.

5 Export your project to a file or to an audio CD. For more information, 
see Completing Sound Editor projects on page 92.
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About adding audio clips
A Sound Editor project is a collection of audio clips. You can add audio 
clips from various sources, improve their quality and add special effects.

You can add audio clips in any of the following ways:

■ Add audio files stored on your hard disk or removable disc storage. For 
more information, see Adding audio files on page 86.

■ Copy audio tracks from CD. For more information, see Adding tracks 
from audio CDs on page 87.

■ Record audio from analog sources, such as a microphone, LP records, 
or tapes. For more information, see Recording from an audio input 
device on page 64.

Adding audio files
With Sound Editor, you can add digital audio files to a project from your 
hard disk, or from removable disc storage. 

Note  You can only add files in formats supported by Sound 
Editor. When you browse for files to add, only files with 
supported formats are visible.

To add audio files to your project:

1 To insert an audio file into an existing audio clip in your project, select 
the audio clip in the Project View area.

In the Clip Editor, click to move the playback cursor to the location at 
which you want to insert the audio file.

2 In the task area, under Add to Project, click Add Audio File. The 
Media Selector window opens.

3 In the Media Selector window, browse to and select the desired files. 

Tip:  For more information about the Media Selector views, click Help 
on the Media Selector window.

4 Click Open.

The selected audio file appears in the Clip Editor.
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Adding tracks from audio CDs

To add tracks from audio CDs to your project:

1 Insert the CD from which you want to copy tracks into your CD drive.

2 In the task area, under Add to Project, click Import from CD. 

The Select Source dialog box opens. 

3 In the Browse area, click the drive containing the audio CD.

4 In the Track View page on the right, select the tracks you want to 
import, and then click OK.

Tip:  To select multiple tracks, hold down the Ctrl key while you click 
the tracks to be imported.

The Import from CD dialog box appears. 

5 In the Import Settings box, select one of the available formats. To 
define your own combination of settings, including alternate file 
format, encoder type, bit rate, and file location, select Custom and 
click Options (see the following step).

6 Optional: To define custom settings, click Options. The Output 
Settings dialog box appears. For more information, click Help in the 
dialog box.

7 In the Save To box, enter the folder in which the tracks will be saved.

8 Click Save.

The tracks appear as audio clips in the Clip Editor.
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About editing and applying effects
You can use Sound Editor to make changes to audio clips. Not only does 
Sound Editor let you save your recorded audio to any other supported file 
format (similar to converting audio file formats), it also lets you edit and 
enhance your audio clip using the available audio effects and editing tools.

Selecting the waveform region to edit
You can apply an edit or effect to an entire audio clip or to a selected part of 
a clip. To edit or add audio effects to your clip, use the playback buttons or 
the Zoom buttons to identify the part of the waveform that you want to 
edit. When you find the region that you want to edit, select it in one of the 
following ways:

To select all tracks:
■ Choose Edit > Select All.

To select a single track, use one of these methods:
■ In the task area, under Project View, expand Tracks, and click a track.

■ To select the track immediately following the currently selected track, 
choose Edit > Select Next Track.

■ To select the track immediately preceding the currently selected track, 
choose Edit > Select Previous Track.

To select a clip:
■ In the task area, under Project View, expand Clips, and click a clip.

To select a part of a waveform, use one of these methods:
■ In the Clip Editor, click and drag your mouse cursor from the 

beginning of the selection to the end. Your selection is highlighted on 
the waveform.

■ If you have inserted markers into the waveform, you can select the area 
between the markers. In the Clip Editor, right-click the section of the 
waveform you want to select, and choose Select Area Between 
Markers.
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Basic editing
You can delete, copy, or move a clip or part of a waveform. 

To delete a clip or part of a waveform:

1 Select the clip or waveform region you want to delete. For information 
on how to select a waveform, see Selecting the waveform region to edit 
on page 88. 

2 Choose Edit > Delete.

To copy a clip or part of a waveform:

1 Select the waveform region you want to copy. For information on how 
to select the waveform, see Selecting the waveform region to edit on 
page 88.

2 Choose Edit > Copy.

3 Move the playback cursor to the location to which you want to copy 
the waveform region, and choose Edit > Paste.

To move a clip or part of a waveform:

1 Select the waveform region you want to move. For information on 
how to select the waveform, see Selecting the waveform region to edit on 
page 88.

2 On the Clip Editor toolbar, click Cut.

3 Move the playback cursor to the location to which you want to move 
the waveform region, and choose Edit > Paste.

To undo the last edit step:
■ Choose Edit > Undo.

To redo the last edit step that was undone:
■ Choose Edit > Redo.
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Adding or deleting track separators
You can use Sound Editor to add track separators to or delete them from 
your recording. For example, if you intend to play your recording as a 
playlist, or burn it to disc, you will want to easily identify the tracks and 
navigate them with your player.

Tip:  To make editing easier, maximize the Sound Editor window for a 
higher resolution display of your audio waveform.

To add track separators:

1 Play your recording to determine where you want to place a track 
separator.

2 When the playback cursor reaches that location, click Add New 
Track.

3 Repeat Step 1 to Step 2 for each track separator you want to add.

4 To check the placement of your track separator, listen to your 
recording by playing it from the beginning, and then clicking the Next 
and Previous playback controls to advance to the next track break.

5 If you are not satisfied with the location of the track separator, 
reposition it by dragging the track break flag to move it to the desired 
location.

6 Optional: Rename and tag the tracks by right-clicking the track on 
the Track Bar and choosing Edit Track Info. 

The Edit Audio Tags dialog box appears. For more information, click 
Help in the dialog box. 

Previous 

Next 
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To delete a track separator:

1 Select the track separator that you want to remove.

2 Click Delete Track.

For more information about markers, see Adding or deleting track 
separators on page 90.

Installing new sound effects
Sound Editor supports VST (Virtual Studio Technology) sound effects. 
Once the effects are installed on your computer, you can select them from 
the Sound Effects menu on the Clip Editor toolbar.

If the VST sound effect comes with an installation program, use that 
program to install the sound effect. If it does not, use the following 
procedure:

Note  Some VST plug-ins may not be compatible with Vista; be 
sure to check with the plug-in developer. 

Only install plug-ins from a trusted source. Sonic assumes no 
responsibility for problems caused by plug-in installation. 

We recommend that you log in as Administrator when installing 
VST plug-ins.

To install a VST plug-in:

1 In Sound Editor, click Sound Effects and choose VST > Add VST 
effect.

2 Browse to and select the VST file, and click Add.

Note  VST sound effects are implemented as .dll files, but they 
may be distributed as archives (such as .zip files). Extract them 
from the archive before installing.
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The VST effect is added to the list of Sound Effects.

Tip:  When you delete the effect from your computer, it is removed 
from the list.

Completing Sound Editor projects
When you finish making changes to your Sound Editor project, you have 
several options:

■ Save your project to a Sound Editor project format. For more 
information, see Saving Sound Editor projects on page 93.

■ Export an audio clip to a single file. For more information, see 
Exporting audio clips on page 93.

■ Export a set of tracks or audio clips to multiple files. Sound Editor lets 
you export each track or audio clip from your project to a separate file. 
For more information, see Exporting sets of tracks or audio clips on 
page 94.

■ Burn your tracks or clips to audio CDs. If you have too many tracks to 
fit on one audio CD, Sound Editor will automatically span them across 
multiple CDs. For more information, see Burning tracks or clips to 
audio CDs on page 96.

Note  The output medium you use for your music determines 
the best format in which to save your audio files. 
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Saving Sound Editor projects
Sound Editor lets you save your work to a Sound Editor project file 
(DMSE), so you can continue working on it later. The DMSE format 
preserves all of the information about the audio clips, tracks, and layers 
used in your project.

For more information about the Sound Editor project format, see Sound 
Editor project file format (.dmse) on page 84.

To save your project:

1 Choose File > Save Project.

If this is the first time you are saving your project to a file, the Save As 
dialog box appears.

2 Choose the folder in which you want to save the project, specify the file 
name, and click Save.

Exporting audio clips
Sound Editor lets you export audio clips from your project to a variety of 
popular file formats.

To export an audio clip:

1 Right-click the audio clip in the Project View area, and choose Export 
Current Clip.

The Export Current Clip dialog box appears.

2 In the Output Settings box, select one of the available formats. To 
define your own customized settings, select Custom and click 
Options (see the following step).

3 Optional: To define custom settings, click Options. The File Format 
dialog box appears. For more information, click Help in the dialog 
box. 

4 In the Save To box, specify the folder in which you want to save the 
files, or click Browse to search for a folder.

5 In the File name box, specify the name of the exported file.

6 Click Export.
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Exporting sets of tracks or audio clips
Using the Sound Editor, you can export a set of tracks or audio clips. Each 
track or clip is saved as a separate file.

To export a set of tracks or audio clips to separate files:

1 In the task area, under Export, click Export Tracks/Clips.

The Export Tracks dialog box appears.

2 In the Export Tracks dialog box, choose one of the following options:

■ Use Tracks from Project: Select this option if you want to 

export each track from your project to a separate file.

■ Use Clips from Project: Select this option if you want to export 

each audio clip from your project to a separate file.

3 Select the tracks or audio clips that you want to export.

4 To preview your selection, use the playback controls (Play, Stop, 
Track/Clip Position).

5 In the Output Settings box, select one of the available formats. To 
define your own customized settings, select Custom and click 
Options (see the following step).

6 Optional: To define custom settings, click Options. The Output 
Settings dialog box appears. For more information, click Help in the 
dialog box.

7 In the Save To box, specify the folder in which you want to save the 
files, or click Browse to search for a folder.

8 Optional: To preserve the volume of the audio in the mix, clear the 
Maximize volume before exporting check box.

The total volume of an audio mix is made up of the individual layer 
volumes.

Play Stop Track/Clip Position
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Note  Unless you manually adjust the layers' volume, the more 
layers you have in the mix, the lower is the volume of each 
individual layer.

Selecting this option renders the entire mix, and then maximizes the 
volume of the resulting audio to ensure the loudest sound, while 
avoiding audio distortion.

9 Optional: To rename and tag the tracks, click Edit Audio Tags. 

The Edit Audio Tags dialog box appears. For more information, click 
Help in the dialog box. 

10 Click Export.

Sound Editor exports each selected track or clip.
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Burning tracks or clips to audio CDs

To burn an audio CD:

1 Insert a blank CD into your recorder.

2 In the task area, under Export, click Burn Audio CD.

The Burn Audio CD dialog box appears.

3 In the Burn Audio CD dialog box, choose one of the following options:

■ Use Tracks from Project: Select this option if you want to burn 

tracks from your project to disc.

■ Use Clips from Project: Select this option if you want to burn 

audio clips from your project to disc.

4 Select the tracks or audio clips that you want to burn.

5 In the Disc Size box, select the size of your audio CD.

6 Optional: To add more information about your disc, click Audio CD 
Settings. 

The Audio CD Project Settings dialog box appears. For more 
information, click Help in the dialog box.

7 Optional: Rename and tag the tracks by right-clicking the track on 
the Track Bar and choosing Edit Track Info. 

The Edit Track Info dialog box appears. For more information, click 
Help in the dialog box. 

8 Click Burn.
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Welcome to Music Disc Creator
Music Disc Creator lets you create music compilations to play on your 
home or car stereo, portable music player, DVD player, or on your 
computer. You can use audio files from your music CDs, hard disk, or 
DVD-Video sources to create music discs.

With Music Disc Creator, you can:

■ Import audio from various sources to use in your projects. You can 
import non-protected tracks from your iPod®, rip tracks from CDs, 
import playlists, extract audio from DVDs, or record audio using a 
microphone.

■ Use Quick Sound Editor to trim audio tracks, add fading, and remove 
clicks, crackling, and other unwanted noises.

■ Add track information, such as the artist name, album title, and track 
title—you can search for track information from the online music 
database, or enter your own information.

■ Export tracks to popular audio file formats, or burn your project to 
disc, or create a disc image file. 

■ Send tracks to a portable device, such as an iPod® or PSP™.

To open Music Disc Creator: 
■ From Creator’s main application window, select the Music-Audio task 

category and choose Create Music Disc Projects.
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Types of music discs you can create

Audio CD
An Audio CD is a compact disc (CD) that you can play on both Audio CD 
players and computer disc drives. With Music Disc Creator, you can make 
your own Audio CDs by recording tracks from other Audio CDs or audio 
from DVD-Videos, and from audio files (MP3, OGG, WAV, WMA or other 
supported formats) stored on your hard disk and other discs.

You can span the Audio CD project across several discs—Music Disc 
Creator automatically adds disc breaks, or you can add custom disc breaks. 
Additionally, you can add fade-in and fade-out effects to each track, as well 
as transitions between tracks.

MP3/WMA disc
An MP3/WMA disc is a CD or DVD data disc that can be played on a player 
that supports MP3 or WMA files. With Music Disc Creator, you can make 
your own MP3/WMA discs by recording MP3 or WMA files stored on your 
hard disk and other discs. 

DVD music disc
A DVD Music Disc is a special type of DVD-Video that contains music 
tracks, arranged in menus and track lists. You can play the disc on a set-top 
DVD player, or on your computer using a software DVD-Video player such 
as CinePlayer.

You can add Track List menus to navigate through the DVD Music Disc, 
select from predefined menu styles, and choose background images, track 
illustrations, and other Smart Objects which provide information about the 
tracks on the DVD. 

Note  Some versions of Music Disc Creator may only include one 
project type. 
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Overview of Music Disc Creator projects
This section outlines the basic steps that are common to all Music Disc 
Creator projects. This section gives instructions for the following 
procedures:

■ Select the type of project you want to create.  For more information 
about the types of projects that you can create, see Types of music discs 
you can create on page 99.

Note  Some versions of Music Disc Creator may only include one 
project type. 

■ Add audio tracks to the project. For more information, see Adding 
tracks to your project on page 102 and Finding tracks and managing 
track information on page 106.

■ If needed, trim audio tracks, add fading, and remove clicks, crackling, 
and other unwanted noises in Quick Sound Editor. 

■ If needed, add or edit track information, such as the track names or 
album titles. For more information, see Editing audio tags with the 
Audio Tag Editor on page 70.

■ Preview the tracks in your project. For more information, see 
Previewing tracks on page 111
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Supported file formats
This section describes the types of files that you can use with Music Disc 
Creator. It describes the Music Disc Creator format, and other formats 
supported by Music Disc Creator.

Note  You may be able to import protected tracks into the 
project, but Digital Rights Management (DRM) may prevent you 
from exporting or burning the tracks to disc.

Music Disc Creator’s native format (.DMSA)
DMSA (Digital Media Suite Audio) is the file format for Music Disc Creator 
projects. DMSA files can only be opened in Music Disc Creator. 

Supported audio formats
Music Disc Creator supports a number of file formats, including WAV, 
WMA, MP3, and other popular formats. In addition, Music Disc Creator 
provides advanced options for writing to various audio file formats in the 
Export dialogs.

Supported playlist formats
You can import playlists from many popular players, such as iTunes and 
Windows Media Player, into a Music Disc Creator project. Playlists may 
contain tracks that are unavailable, or tracks that are in unsupported or 
protected file formats. If you import a playlist that includes a protected or 
unavailable track, Music Disc Creator lets you choose whether to download 
or skip the tracks. 
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Adding tracks to your project
There are several ways to add tracks to your projects. This section includes 
the following information and procedures:

■ About protected audio tracks

■ Using the Media Selector

■ Adding tracks and playlists from a hard disk

■ Adding unprotected tracks from your iPod

■ Importing tracks from discs

You can also record audio from an analog source. For more information, 
see Recording from an audio input device on page 64.

About protected audio tracks
Some audio tracks are protected by digital rights management (DRM) 
technology which controls the ways in which you can use the files. For 
example, DRM may allow you to add tracks to only some types of projects, 
or it may prevent you from copying or burning tracks to disc. In some cases, 
if you have purchased burn rights for a track, you may be limited to a 
certain number of burns. 

Music Disc Creator will only allow you to use tracks in ways that are 
permitted by DRM. If you try to add or burn a track for which you do not 
have permission, you will be informed by Music Disc Creator.

Using the Media Selector
The Media Selector lets you add tracks to your projects. You can keep the 
Media Selector open while you work, either as a floating window, or docked 
in the project track list area.

The Media Selector gives you several ways to find, manage, and select tracks 
to add to your project. For example, you can browse for tracks in the My 
Media or Folders views, preview tracks, or move or rename tracks. 

To open the Media Selector, click Add Audio Tracks or Import from CD/
DVD.

For more detailed information about Media Selector and all of its features, 
click Help or press F1 in the Media Selector.
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To select and add tracks to your project:

1 Click a track to select it, or press the Ctrl key to select more than one 
track at a time.

2 Click Add, or drag the tracks into the Track List area.

For more detailed information, click Help or press F1 in the Media 
Selector.

To dock or undock the Media Selector:

1 Click Add Audio Tracks or Import from CD/DVD.

The Media Selector opens in a window outside of the main project 
window.

2 Click the Attach to main window button in the bottom right corner 

of the window .

3 To undock the Media Selector, click the Attach to main window 
button in the top right corner of the Media Selector.

The Media Selector opens in a separate window.

Attach to main window
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Adding tracks and playlists from a hard disk

To add tracks and playlists from your hard disk:

Tip:  You can also add tracks or playlists to your project by dragging 
them from a folder and dropping them into the project window.

1 In the Add to Project area, click Add Audio Tracks.

2 Use the Media Selector to locate the tracks or playlists you want to add.

For more information, see Using the Media Selector on page 102 or 
click Help or press F1 in the Media Selector.

3 Select the tracks or playlists, and then click Add.

Note  If you are adding a playlist that contains tracks that are 
referenced from the Internet, you will be asked to select a folder 
in which to download them. 

The tracks are added to your project.

4 To rearrange the tracks, select and drag them to a new location.

Adding unprotected tracks from your iPod

To add tracks from your iPod:

1 Make sure your iPod is connected to your computer.

2 In the Add to Project area, click Add Audio Tracks.

3 In the Media Selector, click the My Devices tab.

For more information, see Using the Media Selector on page 102 or 
click Help or press F1 in the Media Selector.

4 Select the tracks, and then click Add.

The tracks are added to your project.

5 To rearrange the tracks, select and drag them to a new location.
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Importing tracks from discs
In addition to copying tracks from CDs and DVDs, you can also select 
tracks from disc image files and DVD-Video folders.

■ Disc image files: A disc image file is a complete copy of a disc that is 
stored on your hard disk as a file instead of recorded to a blank disc. 
Valid disc image files include .iso, .c2d (Roxio proprietary format), 
and .cue.

■ DVD-Video folders: A DVD-Video folder is a “VIDEO_TS” folder 
on a disc or hard disk that contains valid DVD-Video source content. 
The audio from each chapter of a DVD-Video folder can be added to a 
project. 

To import tracks from a disc:

1 In the Add to Project area, click Import from CD/DVD.

2 Use the Media Selector to select the CD or DVD drive, or locate a disc 
image file or DVD-Video “VIDEO_TS” folder.

For more information, see Using the Media Selector, or click Help or 
press F1 in the Media Selector.

3 Select the audio CD tracks or DVD-Video chapters you want to copy, 
and then click Add.

4 Optional. Select the import settings you want to use, and then click 
Save.

Tip:  To add or change track information, click Audio Tags. For more 
information, see Editing audio tags with the Audio Tag Editor on 
page 70.

The tracks are added to the project.

5 To rearrange the tracks, select and drag them to a new location. 
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Finding tracks and managing track 
information
This section explains how to add track information and how to create track 
lists by searching for audio tracks.

Track information, called audio tags, can be very useful for finding and 
categorizing your audio tracks. Examples of audio tags are song titles, artist 
and album names, and music genre. When audio tags are complete and 
accurate, Music Disc Creator can automatically create music mixes by 
searching for songs with similar properties. You can add track information 
manually, or let Music Disc Creator search the online music database to 
automatically add it for you.

Chapter 4, Recording and managing audio files, on page 61 also has 
information that you can use while creating Music Disc Creator projects:

■ See Editing audio tags with the Audio Tag Editor on page 70 for more 
information about editing audio tags.

■ See Creating track lists using AutoMix on page 78 for information 
about creating a track list using AutoMix.

Checking for unidentified tracks
Use this procedure to search for new tracks on your computer and add 
them to your music library. 

Note  Depending on the number of unidentified tracks you have, 
the search may take a long time. For example, if you have 
thousands of unidentified tracks, the search may take several 
hours. However, once tracks are identified, the information is 
saved and you will not have to repeat this process.

To scan for and identify new tracks: 

1 Select a location to scan from the drop-down list. For example, you 
can choose to scan all of your hard disks, or your My Music folder, or 
another folder. Click Start Scan to begin.
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You can skip this step if you already have identified tracks in your 
music library. 

Note  When tracks are added to your music library, they are left 
in their original location; no copies are made.

The status of the scan is indicated by the progress bar, and by a 
message that displays the number of new tracks that have been found. 
If you need to stop the scan, click Stop and review results.

2 When the scan is complete, click Continue with track identification, 
or select another location to scan and click Start Scan again. 
Otherwise, track identification will begin automatically. 

The track identification status is indicated by the progress bar, and by 
a message that displays the number of tracks that have been identified, 
are unrecognized, or have multiple matches.

3 When track identification is complete, choose one of the following 
options:

■ Click Review Results to see the track information. If some tracks 

had multiple matches, this is where you can select the best track 

information. You can also manually update track identification, if 

necessary.

■ Click Exit.

Note  If you exit now, track identification will not be saved.

4 In the Audio Tag Editor, review the results of the scan. For information 
about the options available in the Audio Tag Editor, click Help or press 
F1, or see Editing audio tags with the Audio Tag Editor on page 70.
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Creating track lists using Search by Tags
Music Disc Creator’s “Search by Tags” feature automatically generates 
tracks lists for your projects. For example, you might use Search by Tags to 
create a track list that includes files of a particular genre or by a particular 
artist.

Note  This feature creates track lists by searching your Roxio 
database of media files. If a track on your computer is not found, 
then it is not in the database. You can add tagged tracks to the 
Roxio database by checking for unidentified files or by editing the 
track information. For more information, see Checking for 
unidentified tracks on page 106, or Editing audio tags with the 
Audio Tag Editor on page 70.

Creating track lists using Search by Tags:

1 Choose Tools > Search by Tags.

2 For Tag, choose the type of tag you want to search for (for example, 
track name or artist name).

3 For Condition, choose how you want to search for the tag (for 
example, choose, Equals or Contains).

4 For Value, enter the values of the criteria the search is based on (for 
example, if you selected “Genre” as a search criterion, you could select 
“Jazz” as the value).

5 To add another rule, click the plus sign. 

6 Optional. For Limit track list to, enter the maximum number of 
tracks, minutes, or megabytes to include in the track list (for example, 
25 tracks, 45 minutes, 20 megabytes).

7 Optional. To add the files to the project in random order, select 
Shuffle result set.

8 Choose how to add the tracks to the project:

■ Add tracks to currently selected track list in project

■ Add tracks as a new track list
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If you chose to add the tracks as a new track list, enter a name for the 
track list.

9 To create the track list, click Search.

10 To add the tracks to the project, click Add to Project.

For more detailed information, click Help or press F1 in the Search by 
Tags dialog box.

Using Beatmatching
Beatmatching automatically adjusts the tempo and synchronizes the beats 
between tracks to create professional sounding audio CDs. You can create 
high-energy transitions between tracks and export your entire track list to 
an audio CD, or as a single file to your portable device.

Note  Beatmatching is only available if Audio CD is selected as 
the project type. Itis not recommended for tracks that have 
drastically different beats per minute. For example, using 
beatmatching for two tracks that are 110 BPM and 140BPM, 
respectively, will result in a rough transition.

To use Beatmatching for an entire track list:

1 Click the Beatmatch button located on the toolbar.

2 Click OK to continue.

Music Disc Creator will then scan your track list, and analyze the 
BPM. When the scan is complete, the BPM for each track will appear 
in the BPM column. 

3 Click any speaker icon in the Transition column to hear how the 
transition between the selected track and the previous track will 
sound.

In some cases, it may not be possible for Music Disc Creator to 
determine the correct location of the beat within a particular song. In 
this case, you can manually adjust the BPM for a track using the BPM 
Editor. 
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To manually beatmatch your track(s):

1 Select the tracks you want to manually beatmatch, then select the 
Beatmatch option from the drop-down menu in the Transition 
column.

Music Disc Creator will then scan all selected tracks, and analyze the 
BPM. When the scan is complete, the BPM for each selected track will 
appear in the BPM column.

2 Trim the silence from the beginning and end of your tracks by right-
clicking on the tracks and selecting Auto Trim Silence.

3 Sort the tracks according to BPM by clicking the BPM column header.

4 Set the transition time by typing the number of seconds to transition 
from one track to the next. 

Tip:  As a general rule, it is recommended that you set the 
Beatmatching transition to 20 seconds or more. If there is a 
significant difference in BPM between two tracks, the transition will 
need to be longer.

5 Click any speaker icon  in the Transition column to hear how the 
transition between the selected track and the previous track will 
sound.

When you are satisfied with the transitions between the tracks in your 
track list, you are ready to export the track list to CD, or to your 
connected portable device.

6 Select an export option from the Export task pane.

Note  If you click either Send to Portable Device, or Export, an 
options dialog will appear. Be sure to select Combine all files 
into one file, including transitions, or your transitions will be 
lost.
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Using the BPM Editor
In some cases, it may not be possible for Music Disc Creator to determine 
the correct location of the beat within a particular song. In this case, you 
can manually adjust the BPM for a track using the BPM Editor. 

To manually adjust the BPM for a track:

1 Select a track by right-clicking, then select Beats per Minute > 

Edit.

The BPM Editor window appears. 

2 Place a check mark in the Metronome while playing checkbox, 
then click the Play button to hear the track along with the metronome.

3 Follow the instructions on the BPM Editor window to adjust the 
location and value of the BPM for the track, until the metronome is 
synchronized with the beats of the music.

4 Click Done when you’re finished.

The selected tracks will now display the new BPM setting in the track 
list window.

Previewing tracks
To preview the tracks in your project, use the playback buttons at the 
bottom of the Music Disc Creator window, or click the Preview button 
beside the track.

Play/
pause

Stop Previous 
track

Next track Mute Volume
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Completing Music Disc Creator projects
When your Music Disc Creator project is complete, you can export the 
tracks to MP3, WAV, or WMA files, or burn your project to CD or DVD, or 
create a disc image file. 

Choose how you want to output your project:

■ Burning projects to disc or saving as disc image files: To save the 
project as a disc image file or burn it to a disc.

■ Exporting tracks: To export tracks to one of several popular audio file 
formats.

■ Sending tracks to a portable device: To send tracks to a portable 
device, such as an iPod® or PSP™.

Note  To send tracks to an iPod, you must have iTunes installed.

You can also archive your Music Disc Creator project. The archive contains 
your Music Disc Creator project file, and a folder that includes all of the 
source files (for example, audio files and photos) that are used in the 
project.
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Burning projects to disc or saving as disc image files
Follow this procedure to burn your project to disc or to create a disc image 
file.

A disc image file is a complete copy of a disc that is stored on your hard disk 
instead of recorded to a blank disc. You can create a disc image file for any 
type of project in Music Disc Creator. 

Note  Some tracks may be protected by DRM, which may 
prevent burning, or limit the number of copies you can burn to 
disc. In addition, protected files may not be saved in a disc image 
file. 

For more information, see About protected audio tracks on 
page 102.

To burn a project to disc or save as a disc image file:

1 Click Output Settings to choose output settings.

For more information, click the Help button in the Output Settings 
dialog box.

2 Click the Burn button.

The Burn Setup dialog box appears.

3 To create a disc image file, select Save disc image file, and then click 
Browse to select the location for the disc image file. Otherwise, to 
burn the project to disc, do not select this check box.

4 Select the burn options as needed, and then click OK to begin burning 
the project to disc or saving the image file. 

For more information about the options in the Burn Setup dialog, 
click the Help button.
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Exporting tracks
Follow this procedure to export tracks to one of several popular audio file 
formats.

Note  Depending on the software version you are running, 
available formats may include WMA, WAV, and MP3. Not all 
formats are available in all versions of Music Disc Creator.

To export a project:

1 Select the tracks you want to export, right-click, and choose Export.

The Export Tracks dialog box appears.

2 From the Output Settings drop-down list, select the file format for 
the exported tracks. 

3 Optional. Click Edit to choose advanced output options such as 
encoding and audio format options.

4 Click Browse to select the location where you want to save the 
exported files.

5 Click Export.
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Sending tracks to a portable device
Follow this procedure to send the tracks in your project to a portable 
device, such as an iPod® (iTunes must be installed) or PSP™, any WMDM 
(Windows Media Device Manager) compliant MP3 player, or any MP3 
device that appears as a drive letter on your computer.

To send tracks to a portable device:

1 Select the tracks you want to send to the device.

2 Right-click, and choose Send to Portable Device.

Tip:  If your project is an MP3/WMA disc, you can send the whole 
project, not just selected tracks, by clicking the Send to Portable 
Device button.

3 Select the device to send the track to from the drop-down list.

4 Optional. To convert all of the tracks to the same file format, check 
Convert to preferred audio format before sending.

5 If you selected the option to convert the audio format, select a format 
from the Preferred Audio Format drop-down list. You can use a 
preset format, or click Edit to customize the format.

For more information about customizing the format, click Help or 
press F1 in the File Format dialog box.

6 Click Send to send the files to the portable device.

7 If playlists are available, select the destination playlist when prompted.
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Welcome to PhotoSuite
With Roxio’s PhotoSuite, it has never been easier to repair, enhance, and 
share your digital photos. 

You can use PhotoSuite to carry out everyday tasks, such as:

■ cropping photos 

■ removing red eye

■ rotating photos

PhotoSuite provides easy-to-use tools to help you improve and repair your 
photos. To improve the quality of your photos, you can use the AutoFix 
tool. With just one click, it automatically adjusts the exposure, saturation, 
and sharpness of your photos. Other tools allow you to adjust these 
properties, as well as tint, and brightness and contrast, manually. 

You can also use PhotoSuite to perform more advanced editing tasks, such 
as adding special effects or correcting exposure problems.

To open PhotoSuite: 
■ From Creator’s main application window, select the Photo task 

category and choose Edit Photos.
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PhotoSuite’s project file format (.DMSP)
DMSP is PhotoSuite's native file format for edited photos and projects. This 
format retains layer information and allows you to “undo” changes you 
have made. With DMSP, both the original settings and the edits (such as 
transformations or special effects) are stored. 

For example, if you crop a photo and save it in DMSP format, you can 
reverse the edit later, retrieving the deleted portion. 

Note  If you save the photo in another format, such as JPEG, 
BMP, or TIFF, only the portion enclosed within the crop lines is 
saved. The cropped portion of the photo, the area of the photo 
lying outside the crop lines, is discarded permanently.

If you share a DMSP file with another user, that user must also have 
PhotoSuite.

Supported file formats
PhotoSuite supports a number of popular file formats, including Windows 
bitmap (BMP), Joint Photographic Experts Group (JPEG), Portable 
Network Graphics (PNG) and Tagged Image File Format (TIFF). 

The output medium you use for your photos determines the format in 
which you save them. For example, to e-mail your photos or post them on a 
web site, save them in JPEG format, to create smaller files. 
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Getting to know the PhotoSuite window
Whether you are working on a single photo or a project, the PhotoSuite 
window includes several main panels:

Task pane Open Files pane Objects pane

Canvas
Canvas
Toolbar Options Bar
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■ Canvas Toolbar: Provides quick access to frequently-used PhotoSuite 
commands.

■ Options Bar: Contains a set of context-sensitive commands that are 
relevant to the selected object.

■ Canvas: Displays the photo or project that you are working with. 

■ Task pane: Gives you quick access to the operations you can perform 
on photos and other objects. 

■ Open Files pane: Shows thumbnails of all the files currently open in 
PhotoSuite.

■ Objects pane: Shows all project objects, including photos, text and 
images, that are displayed in the Canvas.

Using the Photo Projects Assistant
The Photo Projects Assistant helps you create personalized calendars, 
greeting cards, photo albums, posters, gift tags, and more. 

To create a photo project using the Photo Projects Assistant:

1 On the Task Pane, under Open/Create, click Photo Projects.

2 Select the type of project you want to create. 

3 Click Next to continue.

4 Follow the instructions in the Photo Projects Assistant to choose the 
template or style for your project, add photos and text, and so on.
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Creating new photo projects in PhotoSuite
A photo project is a collection of objects, such as photos, text, and graphics, 
placed on a canvas. You can add, remove, and manipulate these objects, and 
apply special effects to them.

You can start a new project with a blank canvas, to which you can add 
photos, text, and clip art, apply effects, and so on.

Note  The optional Photo Projects Assistant allows you to create 
selected types of projects, such as personalized calendars and 
greeting cards.

To create a blank canvas:

1 To open a blank canvas, choose File > New > New Canvas.

The New Canvas dialog box appears.

2 Select a canvas size from the box. If you select Custom Size, enter a 
width and height, and select the units of measure to be used.

3 Set the canvas orientation to Portrait or Landscape.

4 In the Background Color drop-down list, select a color.

Tip:  For more color choices, select More colors. Or use the eye 
dropper: Click the eye dropper tool, and then click a sample of the 
color you want to use. You can click a color anywhere in the 
PhotoSuite window—for example, you can select a color from a photo 
in the Open Files pane.

5 Click OK.

A blank canvas opens in the Canvas area.
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Removing red eye
Using PhotoSuite, you can remove common flaws that often appear in 
photos, such as red eye. Red eye occurs when the camera flash reflects from 
the subjects’ eyes, giving the eyes a red appearance in the photo. 

Follow this procedure to correct the “red eye” that appears when the flash 
from the camera reflects off the subjects’ eyes.

To remove red eye:

1 If the photo you want to edit is an object in the PhotoSuite project file, 
select it in the Canvas.

2 On the Fix your photos tab, click Red Eye.

When you move the cursor over the photo, it becomes a circle with a 
cross-hair.

3 To let PhotoSuite automatically remove red eye from the photo, click 
AutoFix.

4 To remove red eye manually, complete the following steps:

a Use the zoom tools on the Canvas Toolbar to enlarge the photo 
until you can work easily on the eyes.

b Use the slider to increase or decrease the size of the brush until it 
is slightly bigger than the eye.

c Click or brush over the red area of the eye until the red is 
removed.

Tip:  To undo a stroke, on the Canvas Toolbar, click Undo. 
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Cropping photos and objects
Follow this procedure to select an area of interest in a photo or other object, 
and crop or remove the rest of the object. 

Note  If you save a cropped photo in PhotoSuite format (.dmsp), 
the entire original photo is preserved, including the crop settings. 
If you save the cropped photo in any other format, the cropped 
area is permanently deleted.

To crop an object:

1 If you want to crop a photo or any other object in a PhotoSuite project 
file, select it in the Canvas. 

2 On the Fix your photos tab, click Crop.

The object is enclosed by a dashed box. The borders of the box are 
called crop lines. Squares, called resize handles, are located in the 
corners. The area of the photo inside the crop lines is called the area of 
interest. This is area that is kept, while everything outside of the crop 
lines is removed.

3 Select a dimension for the crop area, or move the crop lines to outline 
the area that you want to keep. Use any of the following methods to 
move the crop lines:

■ Drag anywhere on the horizontal or vertical crop lines to move 

them individually.

■ Drag the resize handles to maintain the aspect ratio.

■ Press and hold Shift and drag the resize handles to move both the 

horizontal and vertical crop lines without maintaining the aspect 

ratio.

■ Move the cursor over the area of interest and click and drag the 

crop lines to another location without changing the dimensions 

of the area of interest.
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4 Optional: To view only the area of interest, select the Hide cropped 
area check box.

Tip:  To reset the crop lines, click Reset.
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Rotating photos and objects

To rotate objects:

1 If you want to rotate a photo or any other object in a PhotoSuite 
project file, select it in the Canvas.

2 To rotate the object clockwise or counter-clockwise, on the Canvas 
Toolbar, click Rotate Counter Clockwise or Rotate Clockwise.

3 To specify the degree of rotation for the object, on the Options Bar, in 
the Rotation text box, specify the number of degrees to rotate the 
object, or click Plus (+) or Minus (-). 

Tip:  To rotate the object counter-clockwise, enter a minus sign before 
the number.

Tip:  Click Reset to restore the photo or project object to its original 
orientation.
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Applying special effects
Follow this procedure to apply special effects to a photo or an object in a 
project. There are several types of effects available in PhotoSuite, including 
artistic effects that can make your photo look like an oil or watercolor 
painting, color effects that add a tint to the photo, and many others.

To apply a special effect:

1 If you want to apply an effect to a photo or any other object in the 
PhotoSuite project file, select it in the Canvas.

Tip:  To apply an effect to part of a photo, use the mask feature.

2 On the Enhance your photos tab, click Special Effects.

3 Optional: Select an effect category from the drop-down list. By 
default, the All Effects category is selected. This category shows 
thumbnail examples of all the effects available.

4 Select an effect.

The settings available for the selected effect appear. These settings vary 
depending on the effect. 

5 Optional: To see how the selected object looks with the effect applied, 
select the Show Preview check box.

6 Click Apply.
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Working with text
Use PhotoSuite to add text to a photo or a project (for example, to create 
holiday greeting cards from personal photos). 

To add text:

1 In the Enhance pane, click Add or Edit Text.

The Add or Edit Text dialog box appears and a new text object appears 
on the Canvas, with the text, “Type your text here!” A thumbnail 
representing the text object appears in the Object List.

2 Type your new text in the Add or Edit Text dialog box.

Tip:  To add another text object, click Add a new text object.

To change the font and alignment of text:

1 Select the text object in the Canvas or in the Object List.

2 In the Enhance pane, click Add or Edit Text.

3 To change the font, select a new font from the drop-down list.

4 Select the horizontal justification (left, centered, or right).

5 Select the vertical alignment (top, centered, or bottom).

6 Apply styles to the text (bold, italic, or underlined).

7 Adjust the text size in one of the following ways:

■ In the Size box, enter a font size, and in the Horizontal Scaling 

box, adjust the font width.

The Horizontal Scaling option changes the proportion of the text 
object (that is, the ratio of its height to its width).

■ In the Canvas, drag the resize handles on the text object to adjust 

the size.
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To change the text color and add shading:

This procedure explains how to change the color of the text object, and add 
shading. Shading creates a gradual change from one color to another. For 
example, the text can be blue starting at the left, and gradually change to 
purple on the right.

1 Select the text object in the Canvas or in the Object List.

2 In the Common tasks pane, under Enhance, click Add or Edit Text.

3 In the Primary Color drop-down list, select a color.

Tip:  For more color choices, select More colors. Or use the eye 
dropper: Click the eye dropper tool, and then click a sample of the 
color you want to use. You can click a color anywhere in the 
PhotoSuite window—for example, you can select a color from a photo 
in the Canvas.

4 To add shading, select a color from the Seconary Color drop-down list.

5 To change the appearance of the shading, select a direction from the 
Shading Direction drop-down list.
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To add a text outline or style:

1 Select the text object in the Canvas or in the Object List.

2 In the Enhance pane, click Add or Edit Text.

3 To add an outline, select the Text Outline check box.

4 In the Color drop-down list under the Text Outline check box, select a 
color.

Tip:  For more color choices, select More colors. Or use the eye 
dropper: Click the eye dropper tool, and then click a sample of the 
color you want to use. You can click a color anywhere in the 
PhotoSuite window—for example, you can select a color from a photo 
in the Canvas.

5 Use the slider to indicate the width of the outline. Moving the slider 
from Less to More increases the width of the outline.

6 To add a style, select a style in the Style area. 
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Improving the quality of photos
Using PhotoSuite, you can improve the quality of your digital photos by 
adjusting properties such as exposure and brightness and contrast. 

You can also use the AutoFix feature to automatically adjust the exposure, 
saturation, and sharpness of your photos based on photo analysis and 
predefined settings. 

These procedures show how to improve the quality of your photos:

■ Using the AutoFix feature on page 131

■ Adjusting exposure on page 132

■ Adjusting brightness and contrast on page 133

Using the AutoFix feature
Use the AutoFix feature to automatically adjust the exposure, saturation, 
and sharpness of photos. 

AutoFix analyzes the photo, and then, with one click, fixes flaws using 
predefined settings. You can choose to keep these changes or restore the 
photo to its original settings.

To automatically improve photos using AutoFix:

1 If the photo you want to edit is an object in the PhotoSuite project file, 
select it in the Canvas.

2 In the Common tasks pane, under Fix, click AutoFix.

The AutoFix dialog box appears.

3 Click AutoFix.

The AutoFix tool automatically analyses exposure, saturation, and 
sharpness, and then fixes them based on predefined optimum settings. 

Tip:  To restore the photo to its original settings, click Reset.
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Adjusting exposure
Follow this procedure to improve the quality of over- or under-exposed 
photos. When you adjust the exposure, you change the intensity level of the 
photo’s dark areas and shadows, and its highlights and bright areas.

PhotoSuite can adjust the exposure for you automatically, or you can adjust 
it manually.

To adjust the exposure:

1 If the photo you want to edit is an object in the PhotoSuite project file, 
select it in the Canvas.

2 On the Fix your photos tab, click Exposure.

3 To preview the results of the adjustment before applying them, select 
Show Preview.

4 Choose one of the following ways to adjust the exposure:

■ To let PhotoSuite automatically adjust the exposure, click 

AutoFix. PhotoSuite automatically adjusts the exposure based on 

predefined exposure settings.

■ To manually adjust the exposure, use the sliders to adjust the 

exposure settings for the Dark Areas, Midtones, and Bright 
Areas in the photo.

Tip:  To restore the exposure settings to their original values, click 
Reset.
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Adjusting brightness and contrast

To adjust the brightness and contrast:

1 If the photo you want to edit is an object in the PhotoSuite project file, 
select it in the Canvas.

2 In the Common tasks pane, under Fix, click Brightness and 
Contrast.

3 To preview the results of the adjustment before applying them, select 
Show Preview.

4 Use the sliders to adjust the following settings:

■ Brightness: Increase or decrease the overall brightness of the 

photo.

■ Contrast: Increase or decrease the contrast between the light and 

dark areas of the photo. 

Tip:  To restore these settings to their original values, click Reset.
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Printing photos and projects

To print your photos and projects:

1 From Creator’s main application window, select the Photo task 
category and choose Print.

or

On the PhotoSuite or Media Manager toolbar, click Print.

The Print dialog box opens.

2 If you have more than one printer connected to your computer, select 
a printer from the drop-down list. 

3 Optional: Click Change Settings to change the printer settings, such 
as paper source. For more information about your printer settings, see 
the documentation that came with your printer.

4 In the Size drop-down list, select the size of the paper on which you are 
printing your project.

5 Set the Orientation to Portrait or Landscape.

6 If you are using Media Manager, select the photos to be printed, by 
following these steps:

a On the top right side of the window, click Add Files .

b Browse to and select the photo files to add.

Tip:  To select more than one photo at a time, press and hold the Ctrl 
key while you select the photos. 

c Click Add.
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7 To print one photo per page, follow these steps:

a In the Layout box, select One photo per page.

b To specify the size of the photo, in the Size box, select one of the 
displayed sizes, or one of the following options:

■ Fit to page: Prints the photo as large as possible on the 

selected page size. The photo may be cropped along the 

edges if your printer requires margins.

■ Fit to printer margins: Prints the photo as large as possible 

within the printer margins. The entire photo is visible.

■ Actual size: Prints the photo in its actual size based on its 

dpi value.

■ Custom: Lets you specify a width and height. 

c If you set the Size to Custom, enter the Width, Height, and Units.

d Choose one of these options to resize the photo:

■ Resize to fit: Maintains the current proportions; if the 

photo proportions do not match those of the print area, part 

of the print area may not be used. This option may result in 

a smaller photo than the next option.

■ Crop to fill: Maintains the current proportions; if the photo 

proportions do not match those of the print area, the photo 

may be cropped to fit. This option may result in a larger 

photo than the previous option.

■ Stretch to fit: Adjusts the proportions to match those of the 

print area.

8 To apply the Layout settings to all photos, select Apply to all photos. 
To customize the Layout settings for each page, clear this check box.

9 To position the photo on the page, click and drag the mouse to move 
the photo in the Page Preview window.
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10 To print multiple photos per page, follow these steps:

Note  This option allows you to print multiple copies of the same 
photo on a page. You can also use this option to print single 
photos with special templates, such as T-shirt transfers.

a In the Layout box, select Multiple photos per page.

b In the Category box, specify the paper type.

c In the Template box, specify the template to be used. The 
template determines how the photos are arranged on the page.

d To fill each page with multiple copies of the same photo, select 
Fill each page with the same photo. The number of times the 
photo appears depends on the template you select. To specify the 
maximum number of copies of each photo, select Repeat each 
photo and specify the number of times each photo appears.

e Choose whether to crop the photo to fit the placeholder in the 
template. If the photo proportions are not the same as the 
proportions of the template, the application can crop the photo 
to fit the print area, or leave part of the print area blank. The first 
option may result in a larger photo.

f To rotate the photo to fit the placeholder (for example, to fit a 
portrait photo into a landscape placeholder), select Auto-rotate 
to fit the placeholder.

g Optional: To customize advanced options, click Advanced 
Options. For more information about the advanced options, click 
Help on the Advanced Print Multiple Settings dialog box.
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11 To print thumbnails of your photos, follow these steps:

a In the Layout box, select As a contact sheet.

b Enter the numbers of rows and columns in Rows and Columns, 
respectively.

c In the Spacing box, specify the amount of space to be left 
between the thumbnails.

d Optional: Specify the unit of measurement for the space between 
the thumbnails.

You might use a contact sheet, for example, to compare a set of similar 
photos without using up a lot of printing supplies. 

12 If you are printing multiple pages, you can preview each page. To do 
so, click the tabs for the different pages.

13 In the Print drop-down list, identify the pages you want to print.

14 To specify the number of copies, select the number in the Copies box.

15 To print your project, click Print.
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Tips for improving print quality
The following tips may help you improve the print quality of your photos:

■ Select a high print quality in your printer’s settings. When you choose 
a high quality print setting, the print output improves, but the print 
job takes longer.

■ If you are scanning images, scan at the highest image resolution 
available. Refer to your scanner’s documentation for information 
about setting the best resolution.

■ Select the highest photographic quality for your digital camera. You 
cannot store as many photos on the camera at a time, but the 
higher-quality photos will give you better print results.

■ Use color matching, if your printer supports it. The colors on screen 
do not always match the printed colors. The color-matching feature 
improves consistency between on screen and printed colors. 

■ Use photographic quality printer paper. Photos do not print well on 
laser printer paper. Choose paper designed for color or photographic 
printing so the colors are more vibrant. You can find photographic 
paper at your computer supply store or at some camera stores.

Note  Some color printers require proprietary paper. Check the 
manufacturer’s recommendations.
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E-mailing media files
You can share your photos and other media files with friends and family by 
e-mail.

Using the E-mail Assistant, you can e-mail photos individually, either as an 
attachment or in the body of an HTML-formatted e-mail message (if your 
e-mail program supports HTML-formatted messages), or you can send 
your photos packaged in a slideshow.

To e-mail your files:

1 From Creator’s main application window, select the Photo task 
category and choose Email.

or

On the PhotoSuite or Media Manager tool bar, click E-mail.

2 To add media files to be e-mailed, follow these steps:

a Click Add Files. 

The Add Files dialog box appears.

b Browse to and select the files to be added.
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Tip:  To select more than one media file at a time, press and hold Ctrl 
while you select the files.

c Click Add Files.

3 Select the e-mail program you want to use to send the files by choosing 
one of the following options:

■ Default e-mail client (Microsoft Outlook): E-mail the files 

using your default e-mail program. If you select this option, 

choose whether to send the e-mail in HTML format. If you 

choose this option, the photos appear in the body of the message, 

rather than as attached files.

■ Other (e.g. Yahoo, webmail): Save the files on your hard drive 

and e-mail them later using a web mail account.

4 If you are e-mailing photos, you can choose the format in which they 
will be sent. For example, you may want to convert a photo to best fit a 
particular screen size, or to reduce the size if you are e-mailing a large 
number of photos to someone with a dial-up connection. 

Choose one of the following conversion options:

■ Convert photos to JPEG: Sends the photos in JPEG format. You 

can choose the size of the converted photos:

■ Small (640): Converts photos so that the largest dimension 

(height or width) is 640 pixels. The other dimension is sized 

to maintain the current proportions.

■ Medium (800): Converts photos so that the largest 

dimension is 800 pixels.

■ Large (1024): Converts photos so that the largest 

dimension is 1024 pixels.

■ Original size: Maintains the current size of photos.

■ Make a slideshow: Converts the photos to WMV format.

■ Just send the files with no conversion: Sends the photos 

without changing their file format and size.
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Note  Photo conversion options are available only if you have 
selected photo files to e-mail. 

The conversion does not affect your original files.

5 If you are e-mailing video files, you can optimize their quality by 
setting the conversion options. 

In the Quality box, choose the desired resolution. The higher the 
resolution, the better the picture quality, but the larger the resulting 
file.

Note  Video conversion options are available only if you have 
selected video files to e-mail.

The conversion does not affect your original files.

6 Click OK.

If you chose to use your default e-mail program in Step 3, the 
conversion status indicator appears. When the conversion is complete, 
an e-mail message appears.

If you chose to use an e-mail program other than your default, the Pick 
the location for your e-mail files folder appears. Browse to the location 
in which you want to save the converted files, and click OK. The files 
are converted and copied to this folder. Use the e-mail program to 
attach the files to a message and send them.

7 Complete and send the message. For detailed instructions, refer to the 
documentation for your e-mail client.
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Sharing photos using an online photo 
service
Follow this procedure to use an online photo service to post your photo 
files to an Internet site from which other people can view the files.

To share photos through an online photo service:

1 In Media Manager, choose File > Share Online.

2 Follow the on-screen instructions.

Sharing media files with wireless devices

About My Devices
You can use My Devices view in Media Manager to 

■ browse media files on mobile phones and other compatible wireless 
devices

■ transfer files between your computer and your wireless device, and 
vice versa

■ synchronize files on your computer and wireless device

Transferring files

To transfer files from your computer to a wireless device (such as a 
mobile phone):

1 Select the media files you want to transfer.

Tip:  To select more than one file at a time, press and hold Ctrl while 
you select the files. 

2 On the Task Bar, click Split View.

A new pane opens at the bottom of the window, showing the My 
Media view.

3 In the bottom part of the window, click My Devices to show the My 
Devices view.

4 Select the device to which you want to transfer the files.
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5 To move the files to the device (deleting them from your computer), 
click Move Down. To copy them (keeping them on your computer), 
click Copy Down.

The Transfer dialog box appears, showing the progress of the transfer. 
When the transfer is complete, the dialog box closes automatically. 

Tip:  To hide the dialog box, click Close. 

To transfer files from a wireless device (such as a mobile phone) to 
your computer:

1 If you are not in the My Devices view, in the Browse area, click My 
Devices.

2 Select the media files you want to transfer.

Tip:  To select more than one file at a time, press and hold Ctrl while 
you select the files. 

3 On the Task Bar, click Split View.

A new pane opens at the bottom of the window, showing the My 
Media view.

4 In the bottom part of the window, browse to the album or folder to 
which you want to copy the files.

5 To move the files to your computer (deleting them from the device), 
click Move Down. To copy them (keeping them on the device), click 
Copy Down.

The Transfer dialog box appears, showing the progress of the transfer. 
When the transfer is complete, the dialog box closes automatically. 

Tip:  To hide the dialog box, click Close.
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Synchronizing your mobile device
The synchronization feature performs two functions:

■ automatically backs up files on your mobile device to your PC

■ automatically updates selected files on your mobile device when you 
change them on your PC

To use the synchronization feature, you must:

1 Configure the synchronization settings. These settings

■ assign a name to your mobile device

■ identify the folders on your mobile device that you want to back 

up

■ identify the folders on your PC where you want to store the 

backed up files

■ define the transcoding (file conversion) options you want to use 

when copying files from your PC to your mobile device

2 Identify the files on your PC that you want to keep up-to-date on your 
mobile device.

3 Start the synchronization process.

For detailed instructions, see the following procedures.

To configure the synchronization settings for the first time:
■ The first time you connect your mobile device to your PC, the 

Synchronization Wizard opens. Follow the instructions.

To change the synchronization options at a later time:
■ Choose Tools > Sync Settings.

The Synchronization Wizard opens. Select the device you want to 
configure and follow the instructions to change the options.
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To identify files on your PC that you want to synchronize with your 
mobile device:

1 In the top part of the window, browse to and select the media files you 
want to synchronize with your mobile device.

Tip:  To select more than one file at a time, press and hold Ctrl while 
you select the files. 

2 In the bottom part of the window, click the My Media tab to show the 
My Media view.

3 Click the + beside the My Synced Devices Smart View to expand it.

4 Click the + beside the device Smart View to expand it.

5 Drag the media files into the appropriate mobile device Smart View 
(for example, drag your photo files into the Photos Smart View).

To start the synchronization process:
■ When your mobile device is connected to your PC, right-click the 

mobile device Smart View and choose Sync files to device.

Media Manager begins transferring the files, using the transcoding 
(file conversion) options you defined on the Cell Phone Options 
dialog box. 

Note  Only files that have been updated since the last 
synchronization will be transferred.



Roxio Creator User Guide
www.roxio.com148
Using MediaSpace to share media

About MediaSpace
You can easily authorize PCs and other devices on your home network to 
view your photos and other media files. Use this feature if you want to:

■ access your media files (view photos or play videos) from a different 
computer on your home network

■ allow members of your family to access or download your media files 
from their computers.

MediaSpace is implemented using Universal Plug and Play (UPnP) 
networking technology. All of the UPnP components required for 
MediaSpace are automatically installed with Media Manager. 

For information on how to share media files on your home network, see the 
following procedures:

■ Configuring your home network

■ Enabling or disabling home network sharing

■ Granting access

■ Withdrawing acces

■ Accessing shared files

MediaSpace (UPnP) in a corporate environment
MediaSpace (UPnP) is designed primarily for use on home networks, and 
will allow you to share media between Media Manager running on your PC 
and other PCs or devices that are UPnP-compliant. 

Note  The device or PC which is sharing media must authorize 
other devices or PCs to play that media.

In a corporate environment this may work, but only if all devices or PCs are 
on the same network subnet. (In a larger office there may be several 
different network subnets.)
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Configuring your home network
Before you can use the My MediaSpace feature, you may need to change the 
configuration of your home network. See the following sections for more 
information.

Configuring a router with MediaSpace
To use MediaSpace media-sharing capabilities, your router must be UPnP-
compliant, and UPnP must be turned on. (Usually, you configure your 
router with the software that came with the router, or through a local 
administration web page that you access by typing a specific IP address into 
your web browser.) For most routers, UPnP support is turned on by 
default. 

Using My MediaSpace with a firewall
Many firewall applications warn you about peer-to-peer activity and about 
applications that make use of the Internet. The warning for My MediaSpace 
varies depending on the firewall software but basically asks if you want to 
let one or more Roxio components share files on your network. To use My 
MediaSpace, you will need to grant this access.

Enabling or disabling home network sharing

To enable or disable home networking sharing:

1 On the Task Bar, click Share and choose Manage My MediaSpace 
(UPnP).

The Manage My MediaSpace dialog box appears.

2 To enable home network sharing, click Start Sharing.

The button name changes to “Stop Sharing.”

3 To disable home network sharing, click Stop Sharing.

The button name changes to “Start Sharing.”

4 Click Done to close the dialog box.

Granting access
Follow this procedure to give other users on other computers in your home 
network access to your files.
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To grant access to a device on your home network:

1 On the Task Bar, click Share and choose Manage My MediaSpace 
(UPnP).

The Manage My MediaSpace dialog box appears.

2 Select a device with which you want to share your files, and click 
Authorize.

Repeat this step for each device with which you want to share files.

3 Click Done to close the dialog box.

Withdrawing acces

To withdraw access to your files from a device on your home 
network:

1 On the Task Bar, click Share and choose Manage My MediaSpace 
(UPnP).

The Manage My MediaSpace dialog box appears.

2 Select a device with which you want to share your files, and click 
Deauthorize.

Repeat this step for each device from which you want to withdraw 
access to your files.

Accessing shared files
Follow this procedure to access files on other devices on your home 
network. 

To access files on other devices in your home network:

1 In the Browse area, click My MediaSpace (UPnP) to browse files 
stored on your home network.

The Browse area lists the devices connected to your home network to 
which you have been given access. If the device you are looking for is 
not in the list, make sure that:

■ Media Manager is installed on the device.

■ Your PC has been authorized to view media on the device.
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2 Navigate the folders in the Browse area to look for media files.
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About Video Copy & Convert
Video Copy & Convert is designed to assist you in reproducing material 
that you own the copyright for, or have obtained permission to copy from 
the copyright owner. Unless you own the copyright or have permission to 
copy from the copyright owner, you may be violating copyright law and be 
subject to payment of damages and other remedies. If you are uncertain 
about your rights, contact your legal advisor.

Video Copy & Convert has one or two modes of operation—DVD-Video 
Copy, Video Compilation, or both. 

DVD-Video Copy mode lets you copy an entire DVD disc, disc image file, or 
DVD-Video folder. You can burn the contents to a disc, or create a disc 
image file or DVD-Video folder on your hard disk. 

Video Compilation mode lets you compile movies from multiple sources for 
playback on the device of your choice. You can mix and match video files to 
create movies in a wide range of formats including DVD-Video, DivX, and 
WMV. Add unprotected video files from your iPod to your compilation. 
You can also reformat movies so you can watch them on your video iPod®, 
PSP™, or video cell phone.

To open Video Copy & Convert: 
■ From Creator’s main application window, select either the Data-Copy 

or Video-Movies task category and choose Copy and Convert DVD-
Video.



Copying video and creating video compilations
The Video Copy & Convert window 155
The Video Copy & Convert window

DVD-Video Copy mode

Note  The Burn/Copy Now/Save As button changes depending 
on your task. If an arrow appears to the right of the button, you 
can click for advanced options.

Mode selection buttons
Destination area

Burn/Copy Now/
Save As button
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Copying DVD-Video
DVD-Video Copy mode lets you copy an entire DVD disc, disc image file, 
or DVD-Video folder. You can burn the contents to a disc, or create a disc 
image file or DVD-Video folder on your hard disk. 

Can I copy discs using one disc drive?
You can copy a disc using one recorder, or multiple recorders. If you have 
only one disc recorder, the contents of the disc are first copied to a 
temporary location on your hard disk, and then they are copied to the new 
disc.

Note  You must have enough free space on your hard disk to 
temporarily store the entire contents of your source disc.

DVD-Video sources you can copy from
You can copy DVD-Video from any of the following sources.

■ DVD disc: Requires DVDs that are not copy protected. Some drives 
may not be able to copy DVDs of different types. For example, a DVD-
R drive may not be able to copy a DVD+R disc.

■ Disc image files: A disc image file can contain DVD-Video content or 
other kinds of disc content (for example, Audio CD or Video CD 
content). Valid disc image files include .iso, .c2d (Roxio proprietary 
format), and .cue (BIN/CUE).

■ DVD-Video folders: A DVD-Video folder is a folder on a disc or hard 
disk that contains valid DVD-Video source content. This folder can be 
burned to a DVD-recordable disc and then viewed on a DVD player. 

Note  Only folders containing valid DVD-Video source content 
can be copied using Video Copy & Convert. 
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The DVD-Video folder source can come from any of the following 
sources:

■ A disc containing a “VIDEO_TS” folder which contains valid 

DVD-Video source content. The disc cannot be copy-protected.

■ A disc image file containing valid DVD-Video source content. 

Valid disc image files include .iso, .c2d (Roxio proprietary 

format), and .cue (BIN/CUE).

■ A “VIDEO_TS” folder on your hard disk containing valid 

DVD-Video source content.

Note  If your DVD-Video source files are greater than 4.7 GB in 
size, the files can be compressed so that the final output can fit 
onto a standard 4.7 GB DVD-recordable disc. Video Copy & 
Convert also supports copying without compression for 
supported DVD Double Layer drives.
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Copying DVD discs, disc image files, or DVD-Video 
folders
Follow this procedure to copy a disc, disc image file, or DVD-Video folder 
using either one or two drives.

To copy a disc, disc image file, or DVD-Video folder:

1 In Video Copy & Convert, click DVD-Video Copy if you are not 
already in DVD-Video Copy mode.

2 Select the source to copy:

■ If you are copying a disc, insert the disc that you want to copy 

into your source drive.

In the Source area, select the drive containing the source disc 
from the drop-down list. (This may already be selected by 
default.)

■ If you are copying a disc image file or DVD-Video folder, select 

Browse for Disc Image/DVD-Video Folder from the drop-

down list in the Source area. Media Selector opens. Use it to 

locate the file you want to copy.

For more information about disc image files and DVD-Video 
folders, see DVD-Video sources you can copy from on page 156.

The contents of the source appear in the Contents area of the Source 
area.

3 Optional: Click Language Options to select language options.

For more information, click the Help button in the Language Options 
dialog box.

4 In the Destination area, select one of the following from the drop-
down list:

■ the drive containing the destination disc (if you have only one 

recorder, the drive is selected by default)

■ Disc image file 

■ DVD-Video folder 
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5 Select the write speed and enter the number of copies to create.

Note  These options are only available if you are copying to disc, 
not if you are copying to disc image file or DVD-Video folder.

6 Optional: Select Include Data (ROM) Content from Source if you 
want the copy to include data files that are not part of the DVD-Video 
portion of the disc or folder.

Note  Selecting this option will add all files and folders that are in 
the same folder as the source DVD-Video folder. Adding data 
content may decrease the quality of the video.

7 To begin copying immediately, click the Copy button (or the Save As 
button, if you selected a DVD-Video folder or disc image file for the 
output).

Note  The Copy/Save As button has two modes—Copy Now to 
start burning immediately, and Advanced Copy to launch the 
Burn dialog before copying. The Burn dialog lets you select 
additional options such as burning to more than one drive. To 
select a mode, click the arrow beside the Copy/Save As button, 
and then select Copy Now or Advanced Copy.

For more information, click the Help button in the Burn dialog box or 
the Project Settings dialog box.

The Recording Progress dialog box appears and displays the progress. 
Follow the instructions on the screen. When you are done recording, 
the dialog box indicates that the copy is complete.
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Creating video compilations
A video compilation is a collection of movies (“titles”) from different 
sources. You can mix and match video files to create movies in a wide range 
of formats including DVD-Video, DivX, and WMV. Add unprotected video 
files from your iPod to your compilation. You can also reformat movies so 
you can watch them on your video iPod®, PSP™, or video cell phone.

Video Copy & Convert gives you the option to trim the beginning and end 
points of the movies, add a menu, and select a background style to give 
your video compilation a professional look. DivX and DVD projects can be 
automatically compressed to fit on a single disc or memory card.

Note  Using Video Copy & Convert, your DVD-Video or DivX 
compilation will either have a single menu or no menu at all if 
you choose not to add one. Also note that to play back DivX files 
with menus, your player must support this feature.
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Supported video formats
The table below lists the types of video files that can be included in a 
compilation and the supported output formats (The files supported by 
your version of the product may differ from those listed here):

Supported input formats Supported output formats

■ DVD-Video ■ DVD-Video

■ WMV (Windows Media Video, 
standard and HD)

■ WMV (including HD if 
the source is HD)

■ DivX, including HD DivX and DMF 
— DivX Media Format. (Menus will 
not be imported with DMF files)

■ DivX (including DivX 
with menus)

■ DVR-MS (DVR recorded by 
Windows XP Media Center)

■ 3GP

■ MPEG-4 ■ 3G2

■ H.264 ■ MPEG2

■ MP4 (Part 2) ■ MP4 (Part 2)

■ DV-AVI ■ MPEG-4

■ 3GP (video format for mobile 
phones)

■ .TS (transport streams, including 
ATSC and DVB streams and HD)

■ TiVo

■ MOV (requires QuickTime)
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Notes about source files
Consider the following information as you select source files for your 
compilation:

■ You can only select individual movie titles from a DVD-Video disc, 
not the full DVD with original menus and navigation. The content of 
the disc cannot be copy protected.

■ You can select your iPod as a source (click the My Devices tab in the 
Media Selector), and add unprotected video files to your compilation. 
For more information, click Help or press F1 in the Media Selector.

■ A DVD-Video folder is a folder on a disc or hard disk that contains 
valid DVD-Video source content. This folder can be burned to a 
DVD-recordable disc and then viewed on a DVD player. 

The DVD-Video folder source can come from any of the following 
sources:

■ A disc containing a “VIDEO_TS” folder which contains valid 

DVD-Video source content. The disc cannot be copy-protected.

■ A disc image file containing valid DVD-Video source content. 

Valid disc image files include .iso, .c2d (Roxio proprietary 

format), and .cue (BIN/CUE).

■ Valid disc image files include .iso, .c2d (Roxio proprietary format), 
and .cue (BIN/CUE).

■ For TiVo support, you must have TiVo desktop software installed. To 
find out whether TiVo desktop software is available for your PC, check 
www.tivo.com.
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Notes about output formats
Consider the following information as you select an output format for your 
compilation:

■ The 3GP format is designed for playback on video cell phones. 
However, some phones have a very limited storage capacity. Before 
creating compilations for playback on a cell phone, consult the phone’s 
owner’s manual to determine the maximum size of the video files it 
can hold.

■ The Format drop-down list includes a set of format names and specific 
device names. If you device is listed, choose it from the list. If your 
device is not listed, choose a format supported by your device.
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Creating a video compilation

To add and edit movies:

1 Click the Video Compilation button, if necessary.

Note  Versions of Video Copy & Convert with a single copying 
mode do not have mode selection buttons.

2 Click Add Movies.

3 Select the movies that you want to include in the compilation.

Note  In Video Compilation mode, you can only select 
individual movie titles, not the full DVD with original menus and 
navigation. 

Rename Movie, Delete, Preview/Trim Movie, Up and Down buttons
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Tip:  You can add unprotected video files from your iPod to your 
compilation. Click the My Devices tab in the Media Selector to select 
video files from your iPod. For more information, click Help or press 
F1 in the Media Selector.

To select more than one movie at a time, hold the Ctrl key while you 
select the movies.

As you add movies, thumbnails representing each movie appear in the 
Source area.

4 Click the Up and Down arrow buttons to change the order of the 
movies in the compilation. To remove a movie, click the Delete 
button.

5 Click the Rename Movie button to rename any movie in your 
compilation.

6 Optional: To select whether to include subtitles, and to select the 
audio and subtitle languages to include, click Language Options.

Note  Language options are only available for DVD-Video source 
movies.

Only DVD-Video output supports multiple languages. If you 
choose a video file as your output format, you must select one 
language.

For more information, click Help in the Language Options dialog box.

7 Optional: To trim the start or end points of the movie, select a 
thumbnail image, or select angles to copy (if angles are available), 
double-click the movie, or click the Preview/Trim Movie button.

Selecting or customizing a menu style
Video Copy & Convert comes with a set of professionally designed menu 
styles that you can adapt for your projects. Each style includes attractive 
background images, titles, and buttons. These elements are referred to as 
Smart Objects in Video Copy & Convert. You can modify any of these styles, 
use them as designed, or create your own.
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Note  If you do not choose to create a menu, the movies will play 
sequentially when you insert the disc into a DVD player.

Menus can only be created in Video Copy & Convert if the output 
format is DVD-Video or DivX. If your DivX player does not 
support menus, the movies will play sequentially without a 
menu.

To create a menu:

1 Click Options, and then select Create a Main Menu.

2 Click OK to close the dialog.

3 To select a menu style, click Select Style.

The Style dialog opens. 

The Style tab contains the styles that were supplied with Video Copy & 
Convert and any custom styles that you have saved. The Smart Objects 
tab contains tools you can use to modify an existing style or create a 
new one. For more information on creating menu styles, click the 
Help button on the Style dialog.

4 Once you have selected or created a style. click OK. Save the style if 
asked to do so.
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Selecting an output format and a destination
1 In the Destination area, from the Format drop-down list, select one of 

the available formats.

2 For Output to, select one of the following options:

■ Disc/Disc Image

■ File/Folder

■ Portable Device/Media

3 Optional: Click Options to select options such as whether to use 
more than one disc if necessary.

4 Use the Size drop-down menu to select the type of disc or the output 
device you are planning to use. If your device or media is not listed, 
select Custom. Then use the Custom Output Size dialog to match the 
output size to the capacity of your device or media.

5 Click OK to close the dialog.

6 The Content Quality indicator is updated to reflect the new output 
size. If the quality drops too low, consider removing one or more 
movies from your compilation or choose a different output 
destination.

Note  The Portable Device/Media option becomes active when a 
supported device or media is connected to your computer. This 
option allows you to transfer a compilation directly to the device. 
If your device is not supported, choose File/Folder to save the 
compilation to your hard disc. You can then transfer the 
compilation using the standard methods for your device.

For more information, click the Help button in the Options dialog box.



Roxio Creator User Guide
www.roxio.com168
Completing your compilation
To complete your compilation, click the Burn/Save As/Copy button.

■ In Burn mode, the Burn Setup dialog appears. Select burn options, 
such as the recorder(s) to burn to or to create a disc image file, then 
click OK.

■ In Save As mode, the Save As dialog appears. Use it to select a 
destination for your compilation, then click Save.

■ In Copy mode, a series of dialog boxes take you through the steps to 
convert and copy your compilation to a portable player or media.

Creating a compilation for a portable player
Video compilations can be converted into files that you can play on 
portable video players such as the Apple® iPod® (with video playback) and 
Sony PSP™. Video Copy & Convert can save the converted files on your 
hard disk, transfer them to your music player, or both.

To create a video compilation for playback on a portable player:

1 Connect your portable player to your computer with a suitable USB 
cable.

2 Follow the steps described in Creating a video compilation on page 164 
to set up your compilation. 

3 In the video compilation Destination area, select a portable player 
from the Format drop-down menu.

Look at the choices in the Output to list. If Portable Device/Media is 
available, you have the option of saving the compilation directly to 
your portable device or media as described in Step 5.

4 To save the file on your hard disk, choose File/Folder from the Output 
to list and follow these steps:

a Click the Save As button. 

b Use the Select Folder dialog to select a destination for your file.

c Click the OK button.
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5 To transfer the file directly to your music player or media, choose 
Portable Device/Media from the Output to list and follow these 
steps:

a Click the Copy button. The Select Copy Destination dialog 
appears.

b For PSP™ conversions: Select a PSP™, if you have more than one, 
and click the OK button. If you disconnected your player from 
your computer, you will be asked to reconnect it so the file can be 
transferred.

For iPod® conversions: Select a destination for the file by 
selecting an existing playlist or creating a new one, and click the 
OK button.

Note  If you choose Portable Device/Media when the Always 
save copies to hard drive option is selected, your compilation 
will be saved to your hard disk and to your portable player. Select 
Tools > Options to open the General Options dialog.

If you disconnect your player or memory card from your 
computer while a file is being transferred, the copy process will be 
aborted and you will have to start over.
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About Creator Classic
Use Creator Classic to archive your important files to CD or DVD, or large 
projects to multiple discs. Create multimedia, bootable, and backup discs, 
and more.

To open Creator Classic: 
■ From Creator’s main application window, select the Data-Copy task 

category and choose Burn Data Disc - Advanced.

With Creator Classic, burning a disc is easy to do:

1 Start a Creator Classic project. With Creator Classic, you can create 
the following types of projects:

■ Data Disc 

■ Bootable Disc

Select the type of project you want to create from the Projects or Other 
Tasks area.

For more information about each project type, see Deciding which type 
of project to create on page 174.

2 Add files, folders, and tracks to the project. You can add files and 
folders from your hard disk and other discs to your project. 

3 Burn your disc. When you have added and organized all of the files 
that you want to record to your project, you are ready to burn your 
project to disc.

Note  This chapter gives the basic procedures to create a project 
using Creator Classic. 
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Getting to know the Creator Classic window
The default window that appears whenever you start Creator Classic is an 
untitled Data Disc project. The parts of the window that are common 
across all project types are identified below.

Select Source files

Project Area: Shows the project 
type and the files in the project.

Status Bar Estimated project 
size and number of discs 
needed for selected disc size.

Select project type

Other Tasks 
Area

Select disc size
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Deciding which type of project to create
This section lists the types of projects you can create using Creator Classic, 
and helps you choose the best project type for your needs.

■ Data discs

A data disc is a disc that contains any computer data. With Creator 
Classic, you can make your own data discs by burning files and folders 
from your hard disk and other discs.

Select this project type to include any type of data files on the disc.

■ Bootable discs

A bootable disc is a CD or DVD that contains a bootable image, which 
is an exact representation of a bootable floppy disk or hard disk. With 
Creator Classic, you can make a bootable disc that can be used to start 
your system.

Bootable discs are useful if you want to start your system, bypassing 
the operating system on your hard disk. Bootable discs are also useful 
if you want to run backup, drive utility, or virus scan software.

Note  This chapter gives the basic procedures to create a project 
using Creator Classic. 
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Adding files and folders to your project
You can locate and add files and folders from your hard disk and other discs 
to your project. 

To browse for files and folders and add them to your project:

1 In the Select Source area, you can browse for files and folders in any of 
these ways:

■ Browse your Smart Views and albums. Smart Views are media file 

groupings created and maintained automatically by Media 

Manager, based on characteristics such as media type and date. 

Albums are media file groupings you create and manage yourself.

See the Media Manager Help Center for more information about 
Smart Views and albums.

■ Browse files and folders in the Windows folders on your 

computer.

■ Drag a disc icon onto tthe project window to add the entire 

contents of the disc.

■ Click My MediaSpace (UPnP) to browse files stored on your 

home network.

See the Media Manager Help Center for more information about 
sharing files in your home network.

■ Click My Devices to browse files on cell phones and other 

compatible devices detected by your computer.

See the Manager Help Center for more information about 
browsing files on other devices.

2 To select more than one file at a time, press and hold the Ctrl key while 
you click the files.
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3 Add the selected files and folders to your project in any of these ways:

■ Click Add

■ Drag files and folders from the Source area to the Project area.

■ Drag files and folders from Windows Explorer to the Project area.

■ Copy and paste files and folders from the Source area or 

Windows Explorer to the Project area.

Note  If you have a large project that cannot fit on a single disc, 
you can record it to multiple discs. For more information, see the 
Creator Classic Help Center.

4 The Status Bar at the bottom of the Project area displays the estimated 
size of your project.

Burning the project to disc
1 When your project is complete, click Burn.

2 Select recording devices from the list. Selecting multiple recording 
devices lets you burn multiple disc copies at the same time.

The default device is checked with a check mark.

3 Insert a writable disc in the disc drive.

4 To view more information about the recording device, or to eject, 
erase or format the disc, click the arrow button beside the check box, 
and choose one of the following options from the drop-down menu:

■ To eject the disc, select Eject.

■ To erase or format the disc, select Erase/Format Disc. Choose 

this option to erase the content of a rewritable disc, or to format a 

blank disc. 
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Note  Nonrewritable discs can be formatted only once, and 
cannot be erased at all. Rewritable discs can be formatted and 
erased multiple times.

5 If you want to create a disc image file, select Save disc image file, and 
then click Browse to specify the name and location of the image file.

A disc image file is a complete copy of the data as it will appear on the 
disc you want to burn, only it’s stored on your hard drive. Saving a disc 
image file is useful if you want to later create another copy of the disc, 
without needing the original one.

Note  When making a disc image file, make sure you have 
enough space on your hard disk to store the disc image file. 

6 Optional: To view or edit burn options, click the Plus (+) sign located 
to the left of Burn Options.

For detailed information about the options available, click Help or 
press F1 in the dialog box.

7 To start burning to disc, click OK.

The Burn Progress dialog box appears, showing you the progress while 
the project is burning to disc.

Tip:  If an error occurs during the burn process, you can find out more 
about the error by clicking on the error link.
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Welcome to CinePlayer
CinePlayer provides the highest quality DVD and high-definition disc 
playback available for your PC, and lets you take advantage of the enhanced 
interactive features now available on many movie discs. You can:

■ Enjoy the InterActual features found on many commercial movie discs 

■ Customize the language, subtitle, and angle options for your DVDs 
and high-definition discs

You control the media player by choosing menu buttons with a mouse or 
remote control. There is also a Settings menu where you can change the 
player settings. To go to any menu, choose its button on the main menu. To 
go back to a previous menu, choose Back with the mouse or press 
Backspace on the keyboard.

When you use a mouse, extra toolbars appear at the top and bottom of the 
media player screen. To find out what any toolbar button does, move the 
mouse over it.

Depending on the software version you are running, some of the features 
described above may not be available.

To open CinePlayer: 
■ From Creator’s main application window, select the Video-Movies 

task category and choose Watch Movies.
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Getting to know CinePlayer

Tip:  Right-click in the CinePlayer window to view features such as 
Closed Captions, Title Menu, Angle, Subtitle, and so on.

CinePlayer buttons
Use the following buttons to navigate through CinePlayer.

Back and Forward buttons let you navigate through pages when using 
InterActual features.

Open lets you browse to select files or DVD-Video (VIDEO_TS) folders.

Click Settings to choose general applications options, Video and DVD 
settings, as well as playback, language, and audio options. For more 
information about the available settings, click Help or press F1 in the 
settings dialog box.

Full-
screen

Eject Disc, Volume, playback controls, 
DVD Menu, and DVD Settings buttons

CinePlayer buttons

Change video 
scaling

Seek bar
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The DVD menu button allows you to navigate the DVD by selecting 

chapters. To navigate by chapter, click the DVD menu button .

Volume, playback controls, HD disc settings
Use the following buttons to control volume and playback, and to display 
the disc settings. The disc settings let you choose from the available disc 
features, such as subtitles, language options, angles, and so on.

Note  Depending on the software version you are running, some 
of the features described above may not be available.

Playing discs
The basic versions of CinePlayer can play these disc formats:

■ DVD-Video 

■ DVD-VR 

■ DVD Slide Show 

■ VCD 

■ VCD Slide Show 

■ SVCD (Super Video CD)

Mute/Volume

Previous/Next 
chapter

Stop DVD menu

A-B repeat

Play/Pause

Eject Video scaling

Full screen

Rewind Fast forward



Watching movies
Playing video from video folders 183
Blu-ray versions of CinePlayer can play unprotected content in these 
additional formats:

■ BDMV and BDAV

■ AVCHD

To play a disc, insert the disc in your PC. CinePlayer will open 
automatically, if it is selected as your default media player. Select Play to 
begin playing the disc. 

Tip:  To make CinePlayer your default media player, click Settings > 
Playback options tab, then select Set as Default DVD Player.

Playing video from video folders
You can play DVD videos from a folder on a disc or on your hard disk. 

The video folder source can come from any of the following sources:

■ A disc containing DVD folders which contain valid video source 
content. 

■ A disc image file containing valid DVD-Video source content. Valid 
disc image files include .iso, .c2d (Roxio proprietary format), and 

.cue (BIN/CUE).
■ A video folder on your hard disk containing DVD video content.

Note  Blu-ray versions of CinePlayer can also play unprotected 
BDMV, BDAV, and AVCHD content.

To play video from a video folder:

1 In CinePlayer, choose Open > Browse Video Folder. A folder 
selection window opens. 

2 Select the video folder you want to play, and choose the Open button 
using your keyboard or mouse.
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Welcome to VideoWave
VideoWave is a powerful but easy-to-use application that lets you create 
your own video projects, called productions. Use your own home videos, 
photos, and music files, and combine them with VideoWave’s special effects 
and transitions, to create professional-looking video productions that you 
can share with friends and family.

This chapter describes how to find your way around the VideoWave 
window. For more information, see Getting to know the VideoWave window 
on page 187. 

This chapter also outlines the steps involved in creating a video production.

To open VideoWave: 
■ From Creator’s main application window, select the Video-Movies 

task category and choose Edit Video - Advanced.



Creating video productions
Getting to know the VideoWave window 187
Getting to know the VideoWave window
This section describes the main areas of the VideoWave window.

Task Pane
The Task Pane contains the Add Content and Tools areas. 

Add Content area
The Add Content area contains buttons that let you add movies, photos and 
video, background audio, text, overlays, video effects, and transitions to 
your production. Click any of these buttons to display the Media Selector or 
Effect Selector.

Production Editor

Preview areaToolbarTask Pane: 
Add Content & Tools areas
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Tools area
The Tools area provides buttons that show the Media Selector, the Effect 
Selector, and the Settings dialog box. 

Preview area
The Preview area displays your production and provides all the tools you 
need to customize the content of your production.There are two Preview 
area toolbars: the standard toolbar, which provides the common tools that 
are always available, and the context-sensitive toolbar, which changes to 
display the tools to manipulate the item you have displayed in the Preview 
area. You can also trim and position items displayed in the Preview area.

Tip:  You can increase the size of the Preview area by hiding the Task 
Pane. You can also drag the split bar between the Preview and 
Production Editor areas to change the size of the Preview area. 

Production Editor
The Production Editor is where you add and arrange the content of your 
video production. You can drag and drop video clips and photos from the 
Media Selector to the Production Editor, and add color panels, audio, 
transitions, overlays, text, and effects. There are two ways to view the 
Production Editor—the Storyline view, and the optional Timeline view.

Media Selector
Use the Media Selector to add content such as images, video, and audio 
clips to the Production Editor. You can open the Media Selector from the 
Add Content area. 

Tip:  When the Media Selector is open, you can dock the Selector to 
the right of the Preview area, by choosing View > Dock Media 
Selector.
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Effect Selector
The Effect Selector provides quick access to all the effects you can add to 
your production. It offers extensive libraries of transitions, video effects, 
overlays, and text effects that you can add to items or your entire 
production in the Production Editor. Once you have added an effect, you 
can continue to work with it to create custom effects that you can save and 
use again. You can open the Effect Selector from the Tools area.

Tip:  When the Effect Selector is open, you can dock it to the right of 
the Preview area, by choosing View > Dock Effect Selector.

Creating your first VideoWave production
This section shows you how easy it is to make a simple movie production 
using video clips, audio files, and enhancements such as transitions.

This procedure shows you five simple steps to making a movie:

1 Add photos and video. Assemble photos and video clips in your 
production.

2 Add audio. Add background audio files to your production.

3 Add transitions. Insert transitions between your video clips, 
including dissolves, fades, and more.

4 Preview. Preview your production.

5 Output your production. Convert or produce a video file that is ideal 
for the way that you plan to use it.
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Step one: Add photos and video clips 
In this step, you add the content—photos and video clips—to your 
production.

Note  If you have the optional Timeline feature, make sure you 
are in Storyline view.

1 In the Tools area, click Show Media Selector.
2 In the Media Selector, browse your computer for media files to use for 

your production. When you locate the photos and video clips you 
want to use, drag them to the Production Editor.

Add as many photos and video clips to your production as you like.

3 Continue with Step two: Add background audio.

Step two: Add background audio
In this step, you add audio files to your production. This audio is known as 
background audio, and will overlap with any native audio built into the 
video itself. You can apply background audio to the entire production, or to 
individual items within the production.

1 In the Media Selector, browse your computer for audio files.

2 When you find the audio file you want to add, add it to the production 
in one of the following ways:
■ To add it to an individual photo or video clip, drag it to the item 

in the production. An Audio icon appears in the Item-level Icon 

container.
■ To add it to the entire production, drag it to the Production 

Editor background (the area between the panels). An Audio icon 

appears in the Production-level Icon container.

3 Continue with Step three: Add transitions.
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Step three: Add transitions
In this step, you add transitions. A transition is the change you see between 
one photo and the next in a slideshow.

Tip:  You can also apply a transition theme, which applies transitions 
of the selected style between all items in your production. For more 
information, see the VideoWave Help file.

To add transitions:

1 In the Tools area, click Show Effect Selector.

2 Click Transitions.

The Transitions view appears, displaying thumbnails of the transitions 
you can use.

3 Optional: To preview a transition, click Play in the lower right corner 
of the thumbnail.

4 From the Effect Selector, drag any transition to an empty transition 
panel between two video clips in the Production Editor.

Add as many transitions as you like.

5 To set the amount of time for which the transition will play, follow 
these steps:

a Select the transition and on the Production Editor toolbar, click 
Trim.

b In the Duration text box, enter the number of seconds you want 
the transition to last. (One second is generally enough.)

c To apply this duration to all transitions you have added to your 
slideshow or movie, select Apply to all.

d To apply this duration to the selected transition, click OK.

6 Continue with Step four: Preview your production.
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Step four: Preview your production
In this step, you preview your production from beginning to end.

To preview your production:

1 In the Production Editor, click the first panel of your production to 
select it.

2 In the Preview area, click Play.

Your slideshow or movie begins playing in the Preview area.

3 Continue with Step five: Output your production.

Step five: Output your production
You can output your production in different ways, depending on what you 
want to do with it.

To output your production in one of many formats:

1 Choose File > Export As. 

You are prompted to save your production.

2 Click Yes, specify a file name, and click Save.

The Make Movie dialog box appears, displaying options for the type of 
files you can output to.

3 Choose how you want to output your production: 

■ Video File: Save your production as a video file. You will be able 

to choose different types.

■ DV Camera: Record the production on a DV camera that is 

connected to your computer.

■ TV or VCR: Record the production on a TV or VCR that is 

connected to your computer.

■ E-mail: Save your production as an e-mail-friendly video clip, 

automatically attached to a new e-mail message created using 

your default e-mail program.
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4 Choose the video file quality settings, or click New to create a new 
quality definition for your production.

5 In the text box, type a name for your production, and if you want, click 
Browse to change the location in which the file is stored on your 
computer.

6 Click Create Video File to generate your production. 

Note  If you need more information at any time, click Help in 
the Make Movie dialog box.

7 Click Close to close the Make Movie dialog box.
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Creating a slideshow
The Slideshow Assistant helps you turn your photos into a slideshow that 
includes background music, your own text, transitions, and theme, in just a 
few steps.

To open the Slideshow Assistant: 
■ From Creator’s main application window, select the Photo task 

category and choose Create Slideshows.

To create a slideshow using the Slideshow Assistant:

1 Choose one of the following ways to open the Slideshow Assistant. 
Open the Slideshow Assistant in one of the following ways:

■ In the main Creator application window, choose the Photos 

project category and click Create Slideshow.

■ In VideoWave, in the Tools area, click New slideshow.

The Slideshow Assistant opens.

2 Click Add Photos to select the photos you want to include in the 
slideshow.

3 Click Add Audio to select the audio you want to include in the 
slideshow.

4 Click Next to continue.

5 Follow the instructions in the Slideshow Assistant to choose the 
transition theme, set the duration, add pan and zoom effects, and 
open the slideshow in VideoWave where you can further modify your 
project.
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Using CineMagic to create movies
CineMagic creates fun movies from your photos and videos by selecting 
photos and scenes from your videos and splicing them together. To be able 
to produce a movie, CineMagic must have twice as much video footage as 
desired in the final movie. For example, if you want your movie to be 10 
minutes long, you must provide at least 20 minutes of video for CineMagic 
to select from.

Note  If there are specific scenes that you want to make sure are 
included, you can identify them. You can also identify scenes that 
you want to have excluded.

To open CineMagic: 
■ From Creator’s main application window, select the Video-Movies 

task category and choose Edit Video.

or

■ In VideoWave, in the Tools area, click New CineMagic Production.

To create a CineMagic production:

Follow these easy steps:

1 Add content: Select the videos and photos you want to include in 
your movie, as well as the background audio.

2 Customize your movie: Choose the movie style and duration.

3 Output your movie: Save it to a file or burn it to a disc.

Follow the instructions in CineMagic to make your CineMagic production.

Creating a video disc using Plug & Burn
Plug & Burn provides a quick and easy way to capture video from your DV 
camera directly to a disc. You can capture selected scenes, or the entire 
video tape. 

If you have an analog capture card installed on your computer, Plug & Burn 
also allows you to capture analog video to a disc. 
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Note  For more information about your analog capture card, 
refer to the documentation that came with the card.

The following steps show how easy it is to use Plug & Burn to capture video 
from a DV camera directly to a disc. 

To open Plug & Burn: 
■ From Creator’s main application window, select the Video-Movies 

task category and choose Plug & Burn.

To create a video disc from video on your DV camera using Plug & 
Burn:

1 Ensure that the DV camera is connected to your computer, and in the 
correct mode to review or play back saved video. 

2 Customize the production settings:

a Choose whether to include a menu on the disc. If you include a 
menu, you can choose a menu style.

b Select the drive to which you want to record, and insert an 
editable disc. 

c Optional: If you want to erase the existing content on the DVD 
disc, click Erase Disc.

Note  For a rewritable or an unfinalized writable disc, if you do 
not erase the disc, the new video will be added to the existing files 
on the disc. 

d Select the disc type from the drop-down list.

3 Click Next. 

4 Customize the capture settings:

a Select the device from which you are capturing video.

b Specify the capture quality. The better the capture quality, the 
better the resulting output, and the greater the resulting file size.
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c Choose whether to create chapters, based on either scene changes 
or elapsed time.

5 In the Movie Name box, enter the name of the new movie.

6 Start capturing:

■ To capture an entire tape, click Capture entire tape.

■ To capture live video, click Capture now. When you are finished 

capturing, click Stop.

■ To capture selected scenes from a tape, use the playback controls 

to start playing the scenes you want to capture, and click Capture 
now. When you are finished capturing, click Stop.

7 To add additional titles, repeat Step 5 and Step 6.

8 Click Finish to start burning the video to a disc. The Burn Project 
dialog box opens. For more information about this dialog box, click 
Help.
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Using SyncIt!
SyncIt! can quickly:

■ Convert video, audio, and photo files from one format to another. The 
original file is kept. For more information, see Converting files on 
page 201.

■ Transfer your media files to a portable device, such as an iPod, PSP, 
Windows Media device, or supported mobile phone. (You can transfer 
files to a device that is not currently connected to your computer. The 
files are stored in a temporary folder, and transferred next time you 
connect the device.) For more information, see Transferring files on 
page 202.

To open Plug & Burn: 
■ From Creator’s main application window, select the Video-Movies 

task category and choose Plug & Burn.
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Converting files

To convert files:

1 Click the target selector, and choose Simple convert.

2 Click the Options menu to display the conversion settings. 

The Options dialog appears with two settings tabs: Audio and Video. 

3 Select the appropriate tab for your conversion job and customize your 
settings. 

4 Click OK.

5 Drag the files to be converted onto the SyncIt! application.

The application shows the conversion progress, and a message displays 
in the Status area when the conversion is complete.

To convert files and save them in a different location:

1 Click the target selector, and choose Convert to folder.

2 Click the Options menu to display the conversion settings.

The Audio settings tab appears, allowing you to customize your 
conversion job.

Note  If you are converting video, select the Video tab and 
customize the settings for your conversion. 

3 Customize your conversion settings, then click OK.

4 Drag the files to be converted onto the SyncIt! application.

The application shows the conversion progress, and a message displays 
in the Status area when the conversion is complete.
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Transferring files

To transfer files to a portable device:

1 Click the target selector, and choose the portable device from the list.

Note  The list contains all of the portable devices that have been 
connected to your computer, even if the device is currently 
disconnected.

2 Click the Options menu to display the settings and to set the 
conversion options:

■ Audio file target: To transfer audio files, from the list, select the 

audio file format supported by your device. For more options 

(for example, to change the target folder on the device) click the 

double arrow beside the Audio file target box.

■ Video file target: To transfer video files, from the list, select the 

video file format supported by your device. For more options (for 

example, to change the target folder on the device) click the 

double arrow beside the Video file target box.

■ Temporary Folder: The folder in which files will be stored if the 

device is not currently connected to your computer. The files will 

be transferred next time you connect the device.

3 Click OK.

4 Drag the files to be transferred onto the SyncIt! application.

The application shows the transfer progress, and a message displays in 
the Status area when the transfer is complete.
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Adding SmartSound background audio
SmartSound is a service that creates background audio that is automatically 
edited to fit the length of your production. 

SmartSound is available to use in VideoWave, MyDVD, CineMagic, and the 
SlideShow assistant.

To use SmartSound audio:

1 In the Type box, choose whether to use music or sound effects as your 
background audio.

2 In the Where to Search box, choose one of the following options:

■ Owned: SmartSound files that you own, including those stored 

on your hard disk and removable discs, such as CD-ROM.

■ All: SmartSound files that you own, plus any available on the 

Internet.

3 If you will be exporting the SmartSound audio, in the Duration box, 
specify how long you want the exported audio to be.

4 To search for audio by Style, follow these steps:

a For Browse by, select Style.

b In the Style/Library box, select the type of music you want (for 
example, Blues).

5 To search for audio by Library, follow these steps:

a For Browse by, select Library.

b In the Style/Library box, select the library you want to use.

6 To search for audio by Title, for Browse by, select Title.

7 In the Title box, select a title.

8 In the Variations box, select one of the available variations.

9 To automatically fit the music to your production, check the Auto Fit 
box.

10 Click Preview to play the selected audio.
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11 Optional: To save your selection as a WAV file, click Export To, 
browse to the folder in which you want to store the new file, enter the 
file name, and click Save.

12 If you own the background audio, you can add it to your project by 
clicking OK. If you don’t own it, you can click Purchase to buy it and 
add it to your project.
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Welcome to MyDVD
With MyDVD, it’s easy to turn your digital home video and photos into 
discs with professional transitions and animated menus.

MyDVD discs play back in most set-top players and in computers with 
compatible drives.

This chapter explains how to:

■ Start your MyDVD project, select a style, add background video or a 
photo, and add background audio.

■ Add, organize, and customize the appearance of menus that you use 
for your project.

■ Add productions (movies and slideshows), which include video clips, 
photos, transitions, and more, to your menus.

■ Preview your project to ensure that it plays the way you want it to 
before you burn it to disc.

■ Burn your project to a disc, or create an image file that you can burn to 
disc later.

To open MyDVD: 
■ From Creator’s main application window, select the Video-Movies 

task category and choose Create DVDs - Advanced.
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Getting to know the MyDVD window
This section describes the MyDVD window Menu Edit view, and the Movie 
Edit View.

The following section describes the main areas of the MyDVD window in 
both the Menu Edit and Movie Edit views.

Menu Edit view
When you are working on a menu, you work in the menu edit view.

Task pane
The task pane gives you quick access to some frequently used commands, 
and provides an easy way to navigate through your project. It contains the 
following areas:

Preview area
Task Pane: Menu Tasks, Edit, and 
Project View areas Toolbar
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■ Menu Tasks area. The Menu Tasks area lets you add content such as 
photos and video clips to the project.

■ Edit area. The Edit area provides the tools you need to edit your 
project’s menu. You can select a menu style or background, or change 
the background audio. 

■ Project View area. The Project View area displays a hierarchical view 
of the project and lets you go directly to individual menus and movies. 

Preview area
The Preview area provides the tools you need to customize the appearance 
of the menus in your project. You can change the appearance of text for 
headings and movie buttons, and arrange the objects on the menu.
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Movie Edit view
When you are editing a movie you work in the Movie Edit view. 

Task pane
The task pane gives you quick access to some frequently used commands. It 
contains the following areas:

■ Add Content area. The Add Content area lets you add content and 
effects to the movie.

■ Tools area. The Tools area provides the tools you need to edit a 
movie.

Preview areaTask Pane: Add Content and 
Tools areas

Toolbar

Production Editor
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Preview area
The Preview area provides the tools you need to customize the content in 
your project. In addition to the preview window, the Preview area contains:

■ the standard toolbar, which provides the common tools that are always 
available

■ the context-sensitive toolbar, which changes to display tools you can 
use to manipulate the item you have selected in the Preview area

■ the Preview and Effect Preview controls

Production Editor
The Production Editor lets you add, remove, sort, and edit video clips, 
photos, color panels, and transitions in your movies. Drag and drop video 
clips and photos from the Media Selector, and also add color panels, audio, 
transitions, overlays, text, and other special effects. 

Features available in both views

Disc size
This is the capacity of the disc on which you will be burning your project.

Project size bar
As you add content to your project, the project size bar shows how much 
disc space the project will require. The disc size limit shows the capacity of 
the disc. Where the project size exceeds the disc capacity, the project size bar 
turns red.

Quality
The quality box specifies the production quality, which is determined by the 
amount of video in the production and the amount of space available on 
the disc. By default, the Fit to Disc option is selected; this option uses the 
highest quality level that will accommodate all of the content. (The quality 
is represented visually by the quality indicator beside this box.) You can 
select a different quality level.
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Overview of creating a MyDVD project
This section gives a general overview of the steps you take to create a disc 
using MyDVD. You can use your favorite video clips, photos, and audio 
clips to quickly and easily make an exciting and creative disc.

What are MyDVD projects?
MyDVD projects are multimedia presentations that can be burned onto a 
disc. 

Projects are organized into menus. Menus can have video or image 
backgrounds, and background audio. Each menu has one or more buttons 
that link to productions or to other menus. Productions (slideshows and 
movies) are collections of video clips and photos. (You can make them 
more interesting by adding transitions that play between the video clips and 
photos.) These buttons can have animated button images.

Note  You may also be able to create “no menu” projects 
containing one or more movies that play in succession.

Steps to create a new project
The following steps show how easy it is to create a disc using media files that 
you capture from your digital device to your computer. 

To create a new project:

1 Use Media Import to capture the media files from a digital device—
such as a digital camera, digital video (DV) camera, scanner, or 
removable device—that is connected to your computer. For more 
information, see Capturing media files on page 212.

2 Select a menu style, a menu background, and menu background 
audio. For more information, see Customizing menus on page 213 and 
Changing or removing background audio on page 222.

3 Add productions to your project. For more information, see Adding 
productions to your MyDVD project on page 214.

Each time you add a production, a new button is added to the menu.
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4 Preview the project to make it sure it plays the way you expect it to. For 
more information, see Previewing MyDVD projects on page 223.

5 Burn the project to a disc, which you can then play on your set-top 
player. For more information, see Burning projects to disc on page 224.

Capturing media files
If you have a digital camera, DV camera, scanner, or other device connected 
to your computer, you can capture photo and video files to use in your 
MyDVD projects. You capture photo and video files using Media Import. 

To start Media Import from MyDVD:
■ In the Menu Tasks area, click Capture/Import.

Media Import opens, and you can select a device and begin capturing 
media files.

When you have finished capturing files, the new media files appear in 
the Recently Captured Items view in the Media Selector; you can add 
them to your MyDVD projects. 
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Working with menus

What are menus?
A menu is a screen containing background photos or video clips, 
background audio, and buttons that link to productions (movies and 
slideshows), and other menus. 

Menus in a MyDVD project work exactly the same way as the menus you 
see when you play a commercial DVD-video disc. These menus typically let 
you choose to play the movie, select audio settings, view bonus material, 
and so on.

A project can have several menus. When you play the project, navigation 
buttons let you move between menus.

You start with an empty menu background, then add movies, background 
audio, and text.

Customizing menus
A menu style is a template that controls the appearance of the menus in a 
project. Each style includes a background design, text properties, 
navigation buttons, button layout, and so on, for both main menus and 
chapter menus. New projects use the default style, but you can quickly 
change individual menus or the entire project by selecting from a variety of 
predefined styles.

To apply a style to the project:

1 In the Edit area, click Change Menu Style.

The Select Menu Style dialog box opens. Available styles are listed on 
the left of the dialog box.

2 Select the style you want.

3 Choose whether to apply the new style to the current menu, all menus 
in the project, or all linked menus in the current menu chain.

4 Click OK.
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Note  The options available depend upon the number of menus 
in your project.

Adding productions to your MyDVD project
A production is a combination of photos or video clips that you assemble. 

When the production is played back, the items in it appear as one 
continuous sequence. 

Movies and slideshows are two types of productions. A movie is a collection 
of video clips and photos that play one after the other. Movies can include 
transitions and other effects. Slideshows are similar to movies, but contain 
only still images and optional background audio. Images generally look 
better in a slideshow than they do when used in a movie. 

DVD-Video and VCD projects can contain up to 98 productions (movies 

and slideshows), whereas DVD+VR projects can contain up to 48 
productions.

You can add several production buttons to each menu, and then arrange 
and resize the buttons as desired. For more information, see Working with 
buttons on page 218.

In the productions themselves, you can add, remove, edit, and rearrange the 
video clips and photos, add transitions, and much more.

Adding movies

To add a movie to the project:

1 On the Menus tab in the Project View area, click the menu where you 
want to add the movie.

2 In the Menu Tasks area, click Add New Movie.

3 Select the files you want to add and then click Add.

Tip:  To add more than one file at a time, press and hold Ctrl while 
you click the files.
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Note  You can add photos, video clips, VideoWave productions 
(DMSM) and slideshows (DMSS). If you select multiple DMSM 
and DMSS files, each one becomes a separate movie. If you select 
multiple photos, they are combined in a slideshow. If you select 
multiple video clips, you can choose whether to add them as 
separate movies, or to combine them into a single movie.

Each time you add a movie to the project, a new button appears on the 
current menu in MyDVD, and a movie icon appears in the Project View 
area (Menus tab). Movies are also listed in the Movies tab in the Project 
View area.

When you add more buttons than can fit on the menu, MyDVD creates a 
new menu automatically, and adds navigation buttons so that you can 
navigate between the menus.

Creating and adding movies with CineMagic
CineMagic is a fully automated editor that transforms your raw video 
footage and audio clips into a polished production, complete with 
transitions. Follow the steps to create captivating, personalized video in a 
few clicks. CineMagic automatically edits your production, trimming and 
adjusting the flow and transitions between your video clips by using the 
tempo of the music clip you add.

To create a CineMagic production:

1 In the Project View area (Menus tab), click the icon of the menu where 
you want to add the movie.

2 In the Menu Tasks area, click Add CineMagic Movie.

CineMagic opens, displaying the main screen.

3 Follow the instructions in CineMagic to make your CineMagic 
production.

Editing productions
You can add additional photos and video clips to your productions, as well 
as the following types of enhancements:
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■ transitions

■ text effects

■ overlays

■ video effects

■ audio effects

To edit a production:

1 In the Project View area (on either the Menu or Movies tab) select the 
movie you want to edit.

2 In the Edit area, click Edit Movie.

For more information, see the MyDVD Help Center.

3 To return to the Menu Edit view, click Back to MyDVD.

Removing productions

To remove a production from the project:
■ Right-click on the production name in the Project View area (Movies 

tab) and choose Delete.

Adding and removing chapters
Chapters are points that you specify in a production by adding markers. 
You can then skip back and forth through chapters during playback. 
MyDVD can automatically detect pauses in the movie and add chapter 
markers for you, or you can specify the points manually. A movie can 
contain up to 99 chapter points.

In DVD projects, you can also add chapter menus that appear as submenus 
when you play the finished disc. Each chapter menu contains buttons that 
link to the movie’s chapter points.

Note  You can only create chapter menus for DVD productions. 
This feature is not available in the VCD edition of MyDVD.

Follow these procedure to mark or remove chapters:
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To mark chapters in a movie:

1 Select the movie in the Project View area, then, in the Edit area, choose 
Edit Chapters. 

2 To mark chapters automatically, follow these steps:

a Choose how to identify chapters. You can identify chapters based 
on scene changes, panel changes, or elapsed time.

b Click Go.

Note  If your movie already contains chapters, MyDVD asks 
whether you want to keep them. To do so, click Yes.

3 If you want to create a submenu containing a button for each chapter, 
select the Generate chapter menu(s) and link to selected button 
check box.

4 To mark chapters manually, follow these steps:

a Use the Preview controls to cue the video to the frame at which 
you want to create a new chapter. 

b Click Add chapter here.

c For each chapter you want to add, repeat Step a and Step b.

5 If you want to create a submenu containing a button for each chapter, 
select the Generate chapter menu(s) and link to selected button 
check box.

6 When you are finished, click OK.

To remove chapters from a movie:

1 Select the movie in the Project View area, then, in the Edit area, choose 
Edit Chapters. 

The Edit Chapters dialog box opens. Existing chapters are listed in the 
right-hand pane of the dialog box.

2 Select the chapter that you want to remove, then press Remove.

3 When you are finished, click OK.
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Working with buttons
MyDVD automatically creates a button on the menu when you add a 
production. You can also perform the following tasks with buttons:

■ Arranging buttons on menus

■ Resizing buttons

■ Changing button thumbnail images

■ Changing button styles

Arranging buttons on menus
You can move the buttons to a new position on the menu. If you are using a 
menu style template and have moved the buttons on the menu, you can 
return the buttons to the default position.

To arrange the buttons on a menu:
■ In the Preview area, click the button and drag it to the new location.

To restore the buttons on a menu to their default position:
■ Choose Menu > Arrange Buttons
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Resizing buttons

To resize a button:

1 In the Preview area, click the button to select it. 

A red bounding box appears around the button.

2 Drag the handles on the sides of the red bounding box. To maintain 
the button’s shape, drag the corner handles. To change the shape, drag 
the handles on the edges.

Changing button thumbnail images
Some button styles can include a thumbnail image. For productions, the 
default thumbnail is a short, animated, segment of the linked production. 
For menus, the default thumbnail shows the linked menu. You can select a 
specific frame to be used as a thumbnail.

To select a frame to use as a button’s thumbnail image:

1 In the Preview area, right-click the button and choose Select 
Thumbnail.

2 Use the Preview controls to locate the frame you want to use, and then 
click OK.

Changing button styles

To change the style of one or more buttons:

1 In the Project View area (Menus tab), click the icon of the menu 
containing the buttons you want to change.

2 To change selected buttons on the current menu, select the buttons.

3 Click Change Button Style.
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4 In the Type box, select the type of button for which you want to 
change the style:

■ Command: To display styles for the Movie and Submenu 

buttons.

■ Next: To display styles for the right arrow button, which displays 

the next linked menu.

■ Previous: To display styles for the left arrow button, which 

displays the previous linked menu.

■ Home: To display styles for the text button labeled “Home,” 

which returns you from a submenu to the parent menu.

■ Up: To display styles for the “up arrow” button, which returns 

you from a submenu to the parent menu.

■ Chapter Index: To display styles for the chapter index buttons, 

which display in some menu styles.

5 Choose whether to apply the change to the selected buttons, all of the 
buttons on the current menu, or all buttons in the project.

6 Drag the style you want to use onto a selected button, if any buttons 
are selected, or onto one of the buttons for which you want to change 
the style.

Working with text
In addition to the menu titles and button labels that MyDVD creates 
automatically, you can add blocks of text to menus. You can edit text blocks, 
including button labels and the menu title. You can also change the 
appearance of the text—font, size, color, and so on.

Adding text to menus

To add a text block to a menu:

1 In the Project View area (Menus tab), click the icon of the menu to 
which you want to add the text.

2 On the Preview toolbar, click Add Text.
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The new text block placeholder appears at the center of the menu.

3 Click the text object to select it, then move it to the desired location on 
the menu by dragging the top or bottom edge of the red bounding 
box.

4 To change the width of the text object, drag the handles on the left and 
right sides of the red bounding box.

To edit the new text block and change its appearance, see Editing text.

Editing text
You can edit any text block on a menu, including button labels and the 
menu title. You can also change the appearance of the text—font, size, 
color, and so on.

To edit text:

1 In the Project View area (Menus tab), click the icon of the menu 
containing the text you want to edit.

2 Select the text you want to edit, and type to replace it.

To change text appearance:

1 In the Project View area (Menus tab), click the icon of the menu 
containing the text you want to edit.

2 Select the text you want to change. 

3 Use the controls on the Preview toolbar to change the font, size, color, 
and style (shadow, bold, and italic) of the selected text, or to change 
the text justification.
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Changing or removing background audio
Many of the menu styles include background audio. You can replace this 
audio with your own music, or you can remove it. 

To change the background audio:

1 In the Edit area, click Change Menu Audio.

2 Use SmartSound to create a background audio track or Media Selector 
to choose a track from your own audio collection. (SmartSound is not 
available with all versions of MyDVD.)

To remove the background audio:
■ Choose Menu > Remove Menu Audio.

Removing items from menus

To remove a button, text object, or overlay from a menu:

1 In the project view area (Menus tab), click the menu containing the 
item you want to remove.

2 On the menu, right-click the item and choose Delete.

Note  When you delete a button that is linked to a single movie 
or menu, that movie or menu is deleted from the project (you are 
prompted for confirmation). If you delete a button that is linked 
to all movies on the menu, or to all movies in the project, only the 
button is deleted.
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Previewing MyDVD projects
Before you burn your project to a disc, you should preview it to make sure 
that it plays the way you expect it to. The MyDVD preview is a lower-quality 
preview designed to provide a convenient way to view your project.

Follow this procedure to preview your project. The remote control that you 
use to control the project playback is different, depending on whether the 
project is a DVD or Video CD project.

To preview a project:

1 On the Preview toolbar, click Preview.

The preview window opens, with the project on the right, and the 
remote control on the left.

2 Use the controls on the remote control to play the project.

Tip:  When previewing some projects, you can also select and activate 
buttons on menus by clicking them.

3 When you are done, click Close to continue working with the project.
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Completing your project
See the following topics to complete your MyDVD project:

■ Burning projects to disc on page 224

■ Erasing discs on page 225

■ Saving projects as disc image files and disc volumes on page 225

■ Deciding which type of disc to use on page 226

■ Testing discs on page 228

■ Disc players supported by MyDVD on page 228

Burning projects to disc
When you finish creating your project in MyDVD, you can burn it onto a 
disc. 

Note  If you use a disc that is not rewritable, make sure that you 
have finished and previewed your project before burning it to 
disc. Once you start burning the disc, you cannot overwrite the 
contents. If you change the project, you must burn it to a new, 
blank disc.

If you are not sure what type of disc to use, see Deciding which type of disc to 
use on page 226 for more information.

To burn a project to disc:

1 Insert a compatible disc in the drive.

2 In Menu Edit view, on the Preview toolbar, click Burn.

3 Select the Burn to disc check box.

4 Select the drive containing the disc you want to burn.

5 Enter a name for the disc in the Disc label text box.

6 Click Burn to begin burning the project.

The Burn Progress dialog box opens, showing you the progress while 
the project is burning to disc. 
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7 When the burn is complete, click OK to close the Burn Progress dialog 
box.

Erasing discs

To erase a disc:

1 Insert the disc that you want to erase.

2 Choose Tools > Erase disc.

The Erase Disc dialog box opens.

3 Select the drive that contains the disc from the Drive list.

4 Click Erase Disc.

Saving projects as disc image files and disc volumes
Instead of burning your project to disc, you can save the entire contents of 
the project into a single file called a disc image. This file contains all of the 
information needed to burn the project to a disc directly from your hard 
disk.

You can also save the project as a disc volume on your hard disk. A disc 
volume is a folder containing all the files that get burned onto a disc.

You might want to save your project as disc image or disc volume for the 
following reasons:

■ To make multiple copies of the project.

■ To allow someone else to burn your project to a disc for you, while 
preventing them from making changes to the project.

■ To postpone burning a completed project.

Note  To burn a disc image or disc volume to disc, use the 
optional Creator Classic component, or other disc burning 
software. 

To save a project as a disc image file:

1 On the Preview toolbar, click Burn.

The Burn dialog box opens.
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2 Select the Save disc image file check box.

3 Click Browse, then follow these steps:

a Locate the folder in which you want to save the disc image file.

b Enter a File name for the disc image file, then click Save.

4 Click Burn to save the disc image file.

To save a project as a disc volume:

1 On the Preview toolbar, click Burn.

The Burn dialog box opens.

2 Select the Create folder set check box.

3 Click Browse, then follow these steps:

a Locate or create the folder in which you want to save the disc 
volume.

b Click OK.

4 Click Burn to save the disc volume data.

Deciding which type of disc to use
While all types of discs allow you to add or delete your files just as you 
would with a hard disk, each media type has different advantages. For 
example, rewritable (RW) media allows you to completely erase and rewrite 
files to it.

For more information, see the disc compatibility section of the Roxio web 
site at http://www.roxio.com/dvd_forum/index.jhtml.

This table shows the properties of the types of media that you can use to 
store your data:

http://www.roxio.com/dvd_forum/index.jhtml
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Media Type
Original 
Capacity Compatible Drives

CD-Recordable 
(CD-R)

210 MB 
650 MB 
700 MB

■ Readable by nearly any drive
■ Recordable by nearly any recorder

DVD-Recordable 
-R format 
(DVD-R)

4.7 GB 
8.5 GB

■ Readable by most DVD-ROM, DVD-R, or 
DVD-RW drives

■ Recordable by DVD-R or DVD-RW 
recorders. 8.5 GB discs are recordable on 
dual-layer recorders.

DVD-Recordable 
+R format 
(DVD+R)

4.7 GB 
8.5 GB

■ Readable by most DVD-ROM, DVD+R, or 
DVD+RW drives

■ Recordable on DVD+R and most DVD+RW 
recorders. 8.5 GB discs are recordable on 
dual-layer recorders.

CD-ReWritable
(CD-RW)

210 MB 
650 MB

■ Readable by most CD-ROM, DVD-ROM, or 
CD-RW drives

■ Recordable and rewritable by most CD-RW 
drives.

DVD-ReWritable
-RW format 
(DVD-RW)

4.7 GB ■ Readable by most DVD-ROM or DVD-RW 
drives

■ Recordable and rewritable by DVD-RW 
recorders

DVD-ReWritable 
+RW format 
(DVD+RW)

4.7 GB ■ Readable by most DVD-ROM or DVD+RW 
drives

■ Recordable and rewritable by DVD+RW 
recorders

DVD-Random-
Access-Memory 
(DVD-RAM)

4.7 GB ■ Readable by most DVD-RAM drives and a 
few DVD-ROM drives

■ Recordable and rewritable by DVD-RAM 
drives

DVD-ReWritable 
Double-Layer

8.54 GB ■ Recordable by DVD-RW DL drives
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Note  Formatted discs have slightly less capacity than 
unformatted ones. This is because a file system is added to the 
disc during formatting.

Testing discs
After you create a disc, you should test it to ensure that it plays correctly. 
Follow this procedure to test your DVD disc. If you do not have a set-top 
DVD player, you can use third-party DVD playback software on your 
computer to test your DVD.

Note  Some older set-top players may have problems playing 
your disc. Some newer model set top DVD players may have 
problems playing a CD-R, but will play a CD-RW. In addition, 
DVD-R and DVD+R are generally more compatible than DVD-
RW and DVD+RW. Only a few set-top players can play DVD-
RAM discs.

To test a disc:

1 Insert the disc into a set-top DVD player.

2 Use the controls on the set-top player to go the main menu of the disc.

3 Test all of the menus and navigation buttons to ensure that the disc 
plays correctly.

Disc players supported by MyDVD
You can play discs burned with MyDVD on most set-top disc players.

For supported media types and formats, see your set-top player 
documentation.
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About Label Creator
Label Creator gives you the tools to make professional-looking labels, 
inserts, sleeves, and case covers for CDs and DVDs. Additionally, Label 
Creator helps you record and organize information about the content of 
your CDs and DVDs on binder pages.You can even create the designs and 
print the labels, inserts, covers, and binder pages while you burn discs.

Label Creator also works with special printers that print designs directly to 

discs, and LightScribe® recorders that burn labels on to discs. Label 

Creator supports many of these popular printers and LightScribe-capable 
burners on the market today. 

To open Label Creator: 
■ Open the Windows Start menu and select All Programs. Click on the 

name of your Roxio software suite and select Label Creator.

or

■ In Express Labeler, click the Label Creator button.

Overview of creating labels and disc inserts
Each set of labels, inserts, sleeves, binder pages, and covers you create is 
called a project, and creating projects is a simple process:

1 Create a new Label Creator project. Select the types of labels or 
inserts you want to create (that is, the layouts), and choose a project 
type (audio, data, or video). 

2 Add information about the disc to your project. The information 
you add depends on the type of disc you are creating the label for. For 
example, for an audio CD or a DVD, you can include the names of the 
audio tracks, the artist, the title, and so on.

3 Apply a style to your project. Choose from a selection of 
professionally designed styles, or create your own custom design.

4 Print your project. Print test pages to make sure your labels, covers, 
and inserts align with the paper properly, and then print your project.
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Getting to know the Label Creator window
The following section describes the main areas of the Label Creator 
window.

The Add Object area
Use the Add Object area to add images, shapes such as rectangles, circles, 
and lines, text, or a picture index to your project. 

The Edit Layout area
The Edit Layout area lets you change the appearance of the layout. In the 
Edit Layout area you can select a Style for your project, show and hide 
Smart Objects, or change the background of your project.

Add Object area Menu bar Layout area

Layout Navigator area

Toolbars

Edit Layout area Select More Layouts button
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The Layout area
A layout is the design for your label, insert, booklet, or cover. The Layout 
area is where you work on the content and appearance of your project.

The Toolbars
The Toolbars provide the tools to work with objects on your layout. The top 
row buttons are always available, for example, the zoom, print, and 
alignment buttons.

The bottom row buttons change depending on the type of object selected in 
the Layout area. For example, if you have selected a text object, the tools are 
text object property tools, such as font and font color. 

The Layout Navigator
The Layout Navigator displays thumbnails of the layouts in the current 
project. You can only work on one layout at a time in the Layout area, but 
thumbnails of the other layouts are displayed in the Layout Navigator. To 
work on another layout, click its thumbnail in the Layout Navigator. 

You can also add layouts to your project by clicking the Select more 
layouts button beside the layout thumbnails.
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Using Express Labeler
You can create labels, inserts and booklets while you’re burning discs, in 
Express Labeler. Express Labeler guides you as you select the project layout 
and style, and the information that will appear on the disc, such as the disc 
title and artist name. 

Express Labeler is the fastest way to create and print your labels. 

To open Express Labeler: 
■ From Creator’s main application window, select any one of the project 

categories and choose Create Labels.

or

■ In Label Creator, choose Tools > Express Labeler.

To use Express Labeler:

1 Select the layouts you want to create. For example, to create a disc label 
and front and back covers for the disc jewel case, select the Disc, 
Front, and Back layouts.

The layouts that you select appear in the bottom Layout Navigator area 
of Express Labeler.

2 Click Next.

3 Choose a project type, style, and content for your labels and inserts:

a Select one of the following project types from the drop-down list:

■ Audio Project

■ Data Project

■ Video Project

b Click Select Style.

The Select Style dialog box appears.

c Select the style that you want for your project, and then click OK.
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Note  In the Use Style Objects area, you can select whether to 
apply the style image (background), object layout (placements), 
and/or font settings.

The style is applied to your project.

d Click Edit Content.

The Smart Object Editor appears.

e Select the Smart Objects that you want to include on your label or 
insert. 

To import the Smart Object information from the disc that is 
currently in the recorder, select Auto-Fill from Disc.

f Click OK.

The project is updated with the content that you selected.

4 When you have finished selecting the project type, style, and content, 
click Next.

5 Choose one of the following options:

■ Print: To print the labels and inserts without saving the project, 

or before saving the project.

■ Save: To save your labels and inserts as a Label Creator project 

that you can print or continue to work with later.

■ Edit in Label Creator: To open Label Creator and continue 

working with this project.
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Search by Tags
overview 108
using to create track lists 108
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selecting
all tracks 88
audio clips 88
media files 55
single track 88
waveforms 88

sending
media files by e-mail 141
productions by e-mail 192
tracks to a portable device 115

shading
adding to text 129

sharing
media files on a home network 

148
photos with an online photo 

service 144
size

changing, for menu text 221
of photos, changing 124

Slideshow Assistant
about 196

slideshows
about 214
adding to MyDVD projects 215
creating 196
viewing 57
See also productions

Smart Views
browsing 47
in Media Manager, about 46
overview 42

SmartSound
using to create background 

audio 203
Sound Editor

overview 82
sound effects

using VST, in Sound Editor 91
special effects

applying to photos 127
starting

Express Labeler 233
home network sharing 149

stopping
home network sharing 149

styles
adding to text 130
applying to layouts 230
changing, for menu text 221

subtitles
including in video compilations 

165
supported file formats

description 101
PhotoSuite 119

Synchronization Wizard 146
synchronized devices

browsing 48
synchronizing

mobile device and PC 146
mobile devices with PCs 146

T
tags

See audio tags
tapes

recording 64
templates

See styles
tempo

using to create a movie in 
CineMagic 215

text
adding outlines to 130
adding shading to 129
adding styles to 130
adding to menus 220
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changing alignment 128
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changing font 128
on menus, editing 221
removing from menus 222

themes
See styles

thumbnails
changing for buttons 219
choosing for albums 52
setting a thumbnail image 165

track information
about 106

track lists
adding tracks to 102
creating using AutoMix 78
creating using Search by Tags 

108
track separators

adding 90
deleting 90

tracks
adding audio tags 106
adding to Music Disc Creator 

projects 102, 104
adding to projects 87
burning 96
checking for unidentified 106
defined 85
defining in Sound Editor 90
exporting 114
exporting sets of 94
finding similar 78
importing from CDs and DVDs 

105
importing from disc image files 

105
importing from DVD-Video 

folders 105
playing 111
previewing 111

protected tracks, about 102
selecting all 88
selecting single 88
sending to a portable device 115

transferring
audio files to a portable device 

77, 202
media files from a wireless device 

145
media files to wireless devices 

144
video files to a portable device 

202
transition 109
transitions

adding to productions 191
trimming

movies 165
tutorials

viewing online 31
TWAIN devices

and Device Type menu 37

U
unidentified tracks

finding 106
Universal Plug and Play

and MediaSpace 148
uploading

media files to wireless devices 
144

UPnP
and MediaSpace 148
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V
VCDs

burning projects to 224
number of productions 

supported on 214
previewing 223

VCR
recording productions to 192

video
creating compilations 160
importing from digital cameras 

38
using CineMagic to create 197

video capture cards
and Device Type menu 37

video clips
adding to productions with 

Media Selector 190
Video Compilation mode

description of interface 161
video compilations

adding a main menu 165
adding movies 164
for portable video players 168
format options 167
including subtitles 165
language options 165
output options 167
overview 160
previewing movies 165
thumbnail images 165
trimming movies 165

Video Copy & Convert
and copyrights 154
description of interface 154
modes of operation 154, 155

video files
browsing 47

converting 201
transferring to a portable device 

202
See also videos

video folders
playing using CinePlayer 183

VIDEO_TS folders
copying 158
description 157, 162

videos
browsing 47
e-mailing 141
previewing 56
sharing with wireless devices 

144
using as album thumbnails 52

VideoWave
description 186
productions, adding to MyDVD 

projects 215
viewing

media files on other devices in 
the home network 150

QuickShows 57
vinyl LPs

recording 64
VST sound effects

installing in Sound Editor 91

W
waveforms

copying part of 89
deleting part of 89
editing 89
moving part of 89
selecting for editing 88

WIA devices
importing photos from 38
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